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About This Manual

Introduction to the Manuals

The following manuals are supplied with your Epson printer. As well as the manuals, see the help included in the
various Epson software applications.

[ Start Here (paper manual)

Provides you with information on setting up the printer, installing the software, using the printer, solving
problems, and so on.

(d User's Guide (digital manual)

This manual. Provides overall information and instructions on using the printer, on network settings when
using the printer on a network, and on solving problems.

You can obtain the latest versions of the above manuals with the following methods.

(A Paper manual

Visit the Epson Europe support website at http://www.epson.eu/Support, or the Epson worldwide support
website at http://support.epson.net/.

(J Digital manual

Start EPSON Software Updater on your computer. EPSON Software Updater checks for available updates of
Epson software applications and the digital manuals, and allows you to download the latest ones.

Related Information
= “Software Update Tools (EPSON Software Updater)” on page 84

Using the Manual to Search for Information

The PDF manual allows you to search for information you are looking for by keyword, or jump directly to specific
sections using the bookmarks. You can also print only the pages you need. This section explains how to use a PDF
manual that has been opened in Adobe Reader X on your computer.

Searching by keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you want to find in the search window,
and then click Search. Hits are displayed as a list. Click one of the displayed hits to jump to that page.

..........
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Jumping directly from bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in that section. To return to the previous
page, perform the following operation on your keyboard.

(4 Windows: Hold down Alt, and then press <.
(4 Mac OS: Hold down the command key, and then press <.

User's Guide

Printing only the pages you need

You can extract and print only the pages you need. Click Print in the File menu, and then specify the pages you
want to print in Pages in Pages to Print.

[ To specify a series of pages, enter a hyphen between the start page and the end page.
Example: 20-25

[ To specify pages that are not in series, divide the pages with commas.
Example: 5, 10, 15

Help @
Copies: |1 = [C1Prnt in grayscale (black and white)
[l 5ave inkitener (0

Cammen s B Farems

Document an d Markups

Seale: 9T%

827 x 1169 Inches.

(@) Pages 5
Page Sizing & Handing (0
Size Paster Multiple Eoaklet eSO |

Marks and Symbols

A Caution:

Instructions that must be followed carefully to avoid bodily injury.

g Important:

Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.

= Related Information
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Links to related sections.

Descriptions Used in this Manual

[ Screenshots of the printer driver screens are from Windows 10 or macOS High Sierra. The content displayed on
the screens varies depending on the model and situation.

[ Tllustrations of the printer used in this manual are examples only. Although there may be slight differences
depending on the model, the method of operation is the same.

Operating System References

Windows

In this manual, terms such as "Windows 10", "Windows 8.1", "Windows 8", "Windows 7", "Windows Vista",
"Windows XP", "Windows Server 2016", "Windows Server 2012 R2", "Windows Server 2012", "Windows Server 2008
R2", "Windows Server 2008", "Windows Server 2003 R2", and "Windows Server 2003" refer to the following
operating systems. Additionally, "Windows" is used to refer to all versions.

[d Microsoft® Windows® 10 operating system

d Microsoft® Windows® 8.1 operating system

(d Microsoft® Windows® 8 operating system

(d Microsoft® Windows® 7 operating system

(d Microsoft® Windows Vista® operating system

[ Microsoft® Windows® XP operating system

[ Microsoft® Windows® XP Professional x64 Edition operating system
[ Microsoft® Windows Server® 2016 operating system

[J Microsoft® Windows Server® 2012 R2 operating system
(d Microsoft® Windows Server® 2012 operating system

[d Microsoft® Windows Server® 2008 R2 operating system
[ Microsoft® Windows Server® 2008 operating system

[J Microsoft® Windows Server® 2003 R2 operating system

d Microsoft® Windows Server® 2003 operating system

Mac OS

In this manual, "Mac OS" is used to refer to macOS High Sierra, macOS Sierra, OS X El Capitan, OS X Yosemite,
OS X Mavericks, OS X Mountain Lion, Mac OS X v10.7.x, and Mac OS X v10.6.8.
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Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this printer. Make sure you keep this manual for future
reference. Also, be sure to follow all warnings and instructions marked on the printer.

[d Some of the symbols used on your printer are to ensure safety and proper use of the printer. Visit the following
Web site to learn the meaning of the symbols.

http://support.epson.net/symbols

(4 Use only the power cord supplied with the printer and do not use the cord with any other equipment. Use of
other cords with this printer or the use of the supplied power cord with other equipment may result in fire or
electric shock.

[d Be sure your AC power cord meets the relevant local safety standard.

[d Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, or options by yourself, except
as specifically explained in the printer's manuals.

(J Unplug the printer and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the casing
damaged; the printer does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

[ Place the printer near a wall outlet where the plug can be easily unplugged.

(A Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in locations
subject to shocks, vibrations, high temperature or humidity.

(d Take care not to spill liquid on the printer and not to handle the printer with wet hands.

(d Keep the printer at least 22 cm away from cardiac pacemakers. Radio waves from this printer may adversely
affect the operation of cardiac pacemakers.

Safety Instructions for Ink

[d Be careful not to touch ink when you handle the ink tank, ink tank cap, and opened ink bottle or ink bottle cap.
[ If ink gets on your skin, wash the area thoroughly with soap and water.

[ If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after
a thorough flushing, see a doctor immediately.

[ If ink gets into your mouth, see a doctor right away.

(d Do not shake an ink bottle too vigorously or subject it to strong impacts as this can cause ink to leak.

[d Keep ink bottle and the ink tank unit out of the reach of children. Do not allow children to drink from or
handle the ink bottle and ink bottle cap.
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Printer Advisories and Warnings

Read and follow these instructions to avoid damaging the printer or your property. Make sure you keep this
manual for future reference.

Advisories and Warnings for Setting Up the Printer

(d Do not block or cover the vents and openings in the printer.

[d Use only the type of power source indicated on the printer's label.

[d Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
(4 Avoid electrical outlets controlled by wall switches or automatic timers.

[d Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

(4 The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over.
Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter
and leave the transformer.

[ If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord's ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

[ If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the printer.

(d When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation
may damage both devices connected by the cable.

[J Place the printer on a flat, stable surface that extends beyond the base of the printer in all directions. The printer
will not operate properly if it is tilted at an angle.

(d Allow space above the printer so that you can fully raise the printer cover.
[d Leave enough space in front of the printer for the paper to be fully ejected.

(d Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct
sunlight, strong light, or heat sources.

Advisories and Warnings for Using the Printer

[d Do not insert objects through the slots in the printer.

(d Do not put your hand inside the printer during printing.

(4 Do not touch the white flat cable inside the printer.

(d Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
(4 Do not move the print head by hand; otherwise, you may damage the printer.

[ If the ink tank is not filled up to the lower line, refill the ink soon. Prolonged use of the printer when the ink
level is below the lower line could damage the printer.
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[d Always turn the printer off using the O button. Do not unplug the printer or turn off the power at the outlet
until the O light stops flashing.

[ If you are not going to use the printer for a long period, be sure to unplug the power cord from the electrical
outlet.

Advisories and Warnings for Transporting or Storing the Printer
[d When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

[d Before transporting the printer, make sure that the print head is in the home (far right) position.

Advisories and Warnings for Using the Printer with a Wireless
Connection

[d Radio waves from this printer may negatively affect the operation of medical electronic equipment, causing
them to malfunction. When using this printer inside medical facilities or near medical equipment, follow
directions from the authorized personnel representing the medical facilities, and follow all posted warnings and
directions on the medical equipment.

[J Radio waves from this printer may negatively affect the operation of automatically controlled devices such as
automatic doors or fire alarms, and could lead to accidents due to malfunction. When using this printer near
automatically controlled devices, follow all posted warnings and directions on these devices.

Protecting Your Personal Information

If you give the printer to someone else or dispose of it, restore the default network settings.

Related Information

= “Buttons and Functions” on page 12

10
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Printer Basics

Part Names and Functions

(1) Control panel Allows you to operate the printer and indicates the printer's status.
(2] Printer cover Open to refill the ink tank or to remove jammed paper.

(3] Ink tank cap Open to refill the ink tank.

(4] Ink tank Contains black ink and is located on the print head.

(5) front cover Open to load paper in the paper cassette.

(1] Output tray Holds the ejected paper.

(2] Paper cassette Loads paper.

(3) Edge guide Feeds the paper straight into the printer. Slide to the edges of the paper.
(4] paper guide extension Slide out to load legal size paper.

1
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J

J
(1) Rear cover Remove when removing jammed paper.
(2] USB port Connects a USB cable to connect with a computer.
(3] ACinlet Connects the power cord.

Control Panel

Buttons and Functions

O © 6 0 o

o )
i-

@ wi-Fi) ([

)

=4

s

= C =
+@T

-

Turns the printer on or off.

Unplug the power cord after checking that the power light is off.

®

When a network error occurs, pressing this button cancels the error. Hold this button down for more than five
seconds to perform Wi-Fi auto setup using the WPS push button.

()

Prints a network connection report allowing you to determine the causes of any problems you may have using the
printer on a network. If you need more detailed network settings and connection status, hold this button down for
at least five seconds to print a network status sheet.

(4] When a error occurs, pressing this button cancels the error.

Hold this button down for at least five seconds to move the ink tank to the ink refilling position, or to return it to
the home position.

(5] Stops the current operation. Cancels paper out errors and paper jam errors.

Hold this button down for five seconds until the () button flashes to run print head cleaning.

12
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Functions using Button Combinations

Wi-Fi + d)

Prevents changes from being made to Epson Connect and Google Connect Print settings.

0.0

Restore Default Network Settings

Turn the printer on while holding down the IB button to restore the default network
settings. When the network settings are restored, the printer turns on and the network status
lights flash alternately.

Print Nozzle Check Pattern

Turn the printer on while holding down the & button to print the nozzle check pattern.

The total number of pages fed through the printer is also printed as well as the nozzle check
pattern.

Lights and Printer Status

Lights on the control panel indicate the status of the printer.

\© 9506 @)

Normal Status

. on

Light Status
@ I:I The printer is connected to a wireless (Wi-Fi) network.
’z,?\ D The printer is connected to a network in Wi-Fi Direct (Simple AP) mode.
Error Status

When an error occurs, the light turns on or flashes. Details of the error are displayed on the computer screen.

I:I/D: On
I:I / I:I: Flashing

Light

Status

Solutions

Il =

Wi-Fi connection error has occurred. Press the Wi-Fi button to clear the error and try again.

13
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Light

Status

Solutions

IN¢

Initial ink charging may not be complete.

See the Start Here poster to complete initial ink
charging.

Ink refilling may not be complete.

Refill the ink inside the ink tank, and then press the
button to return the tank to the home position.

1o

Ink tank cap is not fully closed.

Push in the cap firmly, and then press the O button.

igF

No paper is loaded or more than one sheet
has been fed at a time.

Load paper and press the @ button.

IgE

A paper jam has occurred.

Remove the paper and press the @ button.

Protective material may be inside the printer.

Open the printer cover, remove the protective
material, and then press the @ button.

Bo R

B

(1 The printer was not turned off correctly.*

(1 Because the printer was turned off while
operating, the nozzles may have dried
and clogged.

* The power was turned off with a power
strip or breaker, the plug was pulled out of
the outlet, or an electrical failure occurred.

(1 After clearing the error by pressing the @ button,
we recommend performing a nozzle check. Cancel
any pending print jobs.

[ To turn off the printer, make sure you press the Q)
button.

0o 0

K

When the O light and the K light flash
simultaneously

An ink pad is nearing or at the end of its
service life.

The ink pads need to be replaced.

Contact Epson or an authorised Epson service
provider to replace the ink pad *. It is not a user-
serviceable part.

When a message saying that you can continue

printing is displayed on the computer, press the @
button to continue printing. The lights stop flashing
for the time being, however, they will continue to
flash at regular intervals until the ink pad is replaced.

0
D)

The printer has started in recovery mode
because the firmware update failed.

Follow the steps below to try to update the firmware
again.

1. Connect the computer and the printer with a USB
cable. (During recovery mode, you cannot update the
firmware over a network connection.)

2. Visit your local Epson website for further
instructions.

A printer error has occurred.

Open the front cover and remove any paper inside
the printer. Turn the power off and on again.

If the error continues to occur after turning the power
off and on again, contact Epson support.

*1 In some print cycles a very small amount of surplus ink may be collected in the ink pad. To prevent ink leakage
from the pad, the printer is designed to stop printing when the pad has reached its limit. Whether and how often
this is required will vary according to the number of pages you print, the type of material that you print and the
number of cleaning cycles that the printer performs. The need for replacement of the pad does not mean that your

14
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printer has ceased to operate in accordance with its specifications. The printer will advise you when the pad
requires replacing and this can only be performed by an authorised Epson Service provider. The Epson warranty
does not cover the cost of this replacement.

Related Information

= “Removing Jammed Paper” on page 91

= “Contacting Epson Support” on page 120

= “Installing the Latest Applications” on page 85

15
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Network Settings

Network Connection Types

You can use the following connection methods.

Wi-Fi Connection

Connect the printer and the computer or smart device to the wireless router. This is the typical connection method
for home or office networks where computers are connected by Wi-Fi through the wireless router.

Gib)

N
(t f—
= — l- EPSON J

) ) =

Related Information
= “Connecting to a Computer” on page 17
= “Connecting to a Smart Device” on page 18

= “Making Wi-Fi Settings from the Printer” on page 18

Wi-Fi Direct (Simple AP) Connection

Use this connection method when you are not using Wi-Fi at home or at the office, or when you want to connect
the printer and the computer or smart device directly. In this mode, the printer acts as an wireless router and you

16
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can connect the devices to the printer without having to use a standard wireless router. However, devices directly
connected to the printer cannot communicate with each other through the printer.

/ﬁ/—
l e EPSON J
|
N

—~ —~
—~ —~

The printer can be connected by Wi-Fi and Wi-Fi Direct (Simple AP) connection simultaneously. However, if you
start a network connection in Wi-Fi Direct (Simple AP) connection when the printer is connected by Wi-Fi, the
Wi-Fi is temporarily disconnected.

Related Information

= “Making Wi-Fi Direct (Simple AP) Connection Settings” on page 21

Connecting to a Computer

We recommend using the installer to connect the printer to a computer. You can run the installer using one of the
following methods.

[ Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.

http://epson.sn

[ Setting up using the software disc (only for the models that come with a software disc and users with Windows
computers with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.
Selecting the Connection Methods

Follow the on-screen instructions until the following screen is displayed, and then select the connection method of
the printer to the computer.

17
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Select the connection type and then click Next.
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Select Your Conneclion Method
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Follow the on-screen instructions.

Connecting to a Smart Device

You can use the printer from a smart device when you connect the printer to the same Wi-Fi network (SSID) as the
smart device. To use the printer from a smart device, set up from the following website. Access to the website from
the smart device that you want to connect to the printer.

http://epson.sn > Setup

Note:
If you want to connect a computer and a smart device to the printer at the same time, we recommend connecting the
computer first.

Making Wi-Fi Settings from the Printer

You can make network settings from the printer's control panel in several ways. Choose the connection method
that matches the environment and conditions that you are using.

If the wireless router supports WPS, you can make settings by using push button setup.

After connecting the printer to the network, connect to the printer from the device that you want to use (computer,
smart device, tablet, and so on.)

18
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Related Information

= “Making Wi-Fi Settings by Push Button Setup” on page 19

= “Making Wi-Fi Settings by PIN Code Setup (WPS)” on page 20

= “Making Wi-Fi Direct (Simple AP) Connection Settings” on page 21

Making Wi-Fi Settings by Push Button Setup

You can automatically set up a Wi-Fi network by pressing a button on the wireless router. If the following
conditions are met, you can set up by using this method.

[d The wireless router is compatible with WPS (Wi-Fi Protected Setup).

[d The current Wi-Fi connection was established by pressing a button on the wireless router.

Note:
If you cannot find the button or you are setting up using the software, see the documentation provided with the wireless
router.

1. Hold down the [WPS] button on the wireless router until the security light flashes.

If you do not know where the [WPS] button is, or there are no buttons on the wireless router, see the
documentation provided with your wireless router for details.

= =
2. Hold down the wi-Fi button on the printer for at least five seconds until the ' light and the kew®  light flash
alternately.
)
=

The connection setting will start. When a connection is established, the light turns on.

INolific

Note:

|
o~ | —
The printer is in a connection error status when the B'®" light and the wm®  light flash simultaneously. After clearing
the printer error by pressing the Wi-Fi button on the printer, reboot the wireless router, place it close to the printer and try
again. If it still does not work, print a network connection report and check the solution.

lel=
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Related Information

= “Checking the Network Connection Status” on page 22
= “Printing a Network Connection Report” on page 22

= “When You Cannot Make Network Settings” on page 100

Making Wi-Fi Settings by PIN Code Setup (WPS)

You can connect to an wireless router by using a PIN code that is printed on the network status sheet. You can use
this method to set up if an wireless router is capable of WPS (Wi-Fi Protected Setup). Use a computer to enter a
PIN code into the wireless router.

1. Load papers.

&
2. Hold down the @ button on the printer for at least five seconds until the power light flashes.
The network status sheet is printed.
Note:

&
If you release the @ button within five seconds before the power light flashes, a network connection report is printed.
Note that PIN code information is not printed on this report.

|
= =

3. While holding down the wi-Fi button, press the & button until the B light and the E'? light flash
alternately.

\)

4. Use your computer to enter the PIN code (an eight digit number) printed on [WPS-PIN Code] column of the
network status sheet into the wireless router within two minutes.
=
When a connection is established, the ' light turns on.

INolific

Note:
(A See the documentation provided with your wireless router for details on entering a PIN code.

"' — | ~
[ The printer is in a connection error status when the h ®  light and the wm® light flash simultaneously. After
clearing the printer error by pressing the Wi-Fi button on the printer, reboot the wireless router, place it close to the

printer and try again. If it still does not work, print a network connection report and check the solution.

lesl®E

Related Information

= “Printing a Network Status Sheet” on page 28

= “Checking the Network Connection Status” on page 22
= “Printing a Network Connection Report” on page 22

= “When You Cannot Make Network Settings” on page 100
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Making Wi-Fi Direct (Simple AP) Connection Settings

This method allows you to connect the printer directly to devices without a wireless router. The printer acts as a
wireless router.

ZH = =

1. While holding down the wi-Fi button, press the button until the B'®" light and the em®" light flash
alternately.

Wait until the process ends.

=
When a connection is established, the m®" light turns on.

INoliic

Note:
If you enable Wi-Fi Direct once, it remains enabled unless you restore the default network settings.

2. Load papers.

&
3. Hold down the IB button on the printer for at least five seconds until the power light flashes.

The network status sheet is printed. You can check the SSID and Password for Wi-Fi Direct (Simple AP) on
this sheet.

Note:

&
If you release the Iﬂ button within five seconds before the power light flashes, a network connection report is printed.
Note that the SSID and Password for Wi-Fi Direct (Simple AP) are not printed on this report.

4. On the computer's network connection screen or the smart device's Wi-Fi screen, select the same SSID shown
on the network status sheet to connect.

<Wi-Fi Direct:>

Wi-Fi Direct Mode On
Communication Mode Simple AP
Operation Mode IEEES02.11g/n
Communpnication Snsaasd Eutn

551D DIRECT=-
Fassword

Channel 11

Security Level WPAZ-PSK({AES)
Link Status Unknown
Connected Devices D{Max N}
Client MAC List Wome

5. Enter the password printed on the network status sheet into the computer or smart device.

You can confirm the status of Wi-Fi Direct on the network status sheet.
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Note:
When you connect from a smart device using Wi-Fi Direct connection (for Android)

5 B
When you are using an Android device and connect to the printer using Wi-Fi Direct, theB'®"  light and am®  light flash
simultaneously on the printer.

Press the Wi-Fibutton to allow the connection request.
Press the @ button if you want to reject the connection request.
See Tips on the following website for more details.

http://epson.sn > Support

Related Information

= “Printing a Network Status Sheet” on page 28

= “Checking the Network Connection Status” on page 22

= “When You Cannot Connect Using Wi-Fi Direct (Simple AP) Connection” on page 101

Checking the Network Connection Status

You can check the network connection status in the following way.

Checking the Network Status Using Network Light

You can check the network connection status using the network light on the printer’s control panel.

Related Information

= “Lights and Printer Status” on page 13

Printing a Network Connection Report

You can print a network connection report to check the status between the printer and the wireless router.

1. Load papers.

3
2. Press the Iﬂbutton.

The network connection report is printed.

Related Information

= “Messages and Solutions on the Network Connection Report” on page 23
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Messages and Solutions on the Network Connection Report

Check the messages and error codes on the network connection report, and then follow the solutions.

2 Clum

Check Hetwerk Connection

Check Result FAIL

Error code [ (E=2)

See the Hetwork Status and check Lf the Betwork Nams (S5ID) is

el SOTE au WAAE B8 SSRBGST, b
If the S5ID isx cocrect, sake fuse B9 Gatss the corrach Pl.llul'ﬂ.liﬂ

and try sgain.

If your problems persist.
sad your desussntatiss for halp and networking elps.

Chackad Itams

fizreless Wetworck Masa (S53I0) Check FAIL

Communication Mode Chock Urchgs kod
Security Mode Cheok Unchisa ked
MAC Address Filvering Check Unchieo ked
Security Key/Password Check Unches oed
1P Address Check Unchas ked
Detalled IPF Setup Checok Unchecked

Betwork Status

Printer Hams EPSOH XXXXXX
Pripear Madel XX-XXX Baries

IP Addreas 1£9.254.137.8
Bubnet Mask 255.255.0.0
Default Catoway

Habwork Nasa (S5ID) Epsoniet
Sasueley Hone

Signal Strength Poor

MAC Address FR:DO:2T:40:00:AC

a. Error code

b. Messages on the Network Environment

Related Information
= “E-1” on page 24

= “E-2, E-3, E-7” on page 24
= “E-5” on page 25

= “E-6” on page 25

= “E-8” on page 25

= “E-9” on page 26

= “E-10” on page 26
= “E-11” on page 26
= “E-12” on page 27
= “E-13” on page 27

= “Message on the Network Environment” on page 28
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E-1

Solutions:
[d Make sure the Ethernet cable is securely connected to your printer and to your hub or other network device.
(d Make sure your hub or other network device is turned on.

[ If you want to connect the printer by Wi-Fi, make Wi-Fi settings for the printer again because it is disabled.

E-2, E-3, E-7

Solutions:

[d Make sure your wireless router is turned on.

(d Confirm that your computer or device is connected correctly to the wireless router.

[d Turn off the wireless router. Wait for about 10 seconds, and then turn it on.

[d Place the printer closer to your wireless router and remove any obstacles between them.

[ If you have entered the SSID manually, check if it is correct. Check the SSID from the Network Status part on
the network connection report.

[ If an wireless router has multiple SSIDs, select the SSID that is displayed. When the SSID is using a non-
compliant frequency, the printer does not display them.

[ If you are using push button setup to establish a network connection, make sure your wireless router supports
WPS. You cannot use push button setup if your wireless router does not support WPS.

[d Makes sure your SSID uses only ASCII characters (alphanumeric characters and symbols). The printer cannot
display an SSID that contains non-ASCII characters.

[d Makes sure you know your SSID and password before connecting to the wireless router. If you are using a
wireless router with its default settings, the SSID and password are located on a label on the wireless router. If
you do not know your SSID and password, contact the person who set up the wireless router, or see the
documentation provided with the wireless router.

[ If you are connecting to an SSID generated from a tethering smart device, check for the SSID and password in
the documentation provided with the smart device.

[ If your Wi-Fi connection suddenly disconnects, check for the conditions below. If any of these conditions are
applicable, reset your network settings by downloading and running the software from the following website.

http://epson.sn > Setup

[ Another smart device was added to the network using push button setup.

[d The Wi-Fi network was set up using any method other than push button setup.
Related Information

= “Connecting to a Computer” on page 17
= “Making Wi-Fi Settings from the Printer” on page 18
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E-5

Solutions:

Make sure the wireless router’s security type is set to one of the following. If it is not, change the security type on
the wireless router, and then reset the printer’s network settings.

[ WEP-64 bit (40 bit)

[ WEP-128 bit (104 bit)

J WPA PSK (TKIP/AES)"
O WPA2 PSK (TKIP/AES)"
O WPA (TKIP/AES)

1 WPA2 (TKIP/AES)

* WPA PSK is also known as WPA Personal. WPA2 PSK is also known as WPA2 Personal.

E-6

Solutions:

(d Check if MAC address filtering is disabled. If it is enabled, register the printer'’s MAC address so that it is not
filtered. See the documentation provided with the wireless router for details. You can check the printer’s MAC
address from the Network Status part on the network connection report.

[ If your wireless router is using shared authentication with WEP security, make sure the authentication key and
index are correct.

[ If the number of connectable devices on the wireless router is less than the number of network devices that you
want to connect, make settings on the wireless router to increase the number of connectable devices. See the
documentation provided with the wireless router to make settings.

Related Information

= “Printing a Network Status Sheet” on page 28

E-8

Solutions:
(d Enable DHCP on the wireless router if the printer’s Obtain IP Address setting is set to Auto.

[ If the printer’s Obtain IP Address setting is set to Manual, the IP address you manually set is invalid due to out
of range (for example: 0.0.0.0). Set a valid IP address from the printer’s control panel or by using Web Config.

Related Information

= “Printing a Network Status Sheet” on page 28
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E-9

Solutions:
Check the following.
[ Devices are turned on.

[d You can access the Internet and other computers or network devices on the same network from the devices you
want to connect to the printer.

If still does not connect your printer and network devices after confirming the above, turn off the wireless router.
Wait for about 10 seconds, and then turn it on. Then reset your network settings by downloading and running the
installer from the following website.

http://epson.sn > Setup

Related Information

= “Connecting to a Computer” on page 17

E-10

Solutions:
Check the following.
[d Other devices on the network are turned on.

[d Network addresses (IP address, subnet mask, and default gateway) are correct if you have set the printer’s
Obtain IP Address to Manual.

Reset the network address if they are incorrect. You can check the IP address, subnet mask, and default gateway
from the Network Status part on the network connection report.

If DHCP is enabled, change the printer’s Obtain IP Address setting to Auto. If you want to set the IP address
manually, check the printer’s IP address from the Network Status part on the network connection report, and then
select Manual on the network settings screen. Set the subnet mask to [255.255.255.0].

If still does not connect your printer and network devices, turn off the wireless router. Wait for about 10 seconds,
and then turn it on.

Related Information

= “Printing a Network Status Sheet” on page 28

E-11

Solutions:
Check the following.
(J The default gateway address is correct if you set the printer’s TCP/IP Setup setting to Manual.

(d The device that is set as the default gateway is turned on.

Set the correct default gateway address. You can check the default gateway address from the Network Status part
on the network connection report.
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Related Information

= “Printing a Network Status Sheet” on page 28

E-12

Solutions:
Check the following.
[ Other devices on the network are turned on.

(4 The network addresses (IP address, subnet mask, and default gateway) are correct if you are entering them
manually.

[d The network addresses for other devices (subnet mask and default gateway) are the same.

[ The IP address does not conflict with other devices.

If still does not connect your printer and network devices after confirming the above, try the following.
(d Turn off the wireless router. Wait for about 10 seconds, and then turn it on.

[d Make network settings again using the installer. You can run it from the following website.
http://epson.sn > Setup

[J You can register several passwords on a wireless router that uses WEP security type. If several passwords are
registered, check if the first registered password is set on the printer.

Related Information
= “Printing a Network Status Sheet” on page 28

= “Connecting to a Computer” on page 17

E-13

Solutions:
Check the following.
[ Network devices such as a wireless router, hub, and router are turned on.

[d The TCP/IP Setup for network devices has not been set up manually. (If the printer’s TCP/IP Setup is set
automatically while the TCP/IP Setup for other network devices is performed manually, the printer’s network
may differ from the network for other devices.)

If it still does not work after checking the above, try the following.
[ Turn off the wireless router. Wait for about 10 seconds, and then turn it on.

[d Make network settings on the computer that is on the same network as the printer using the installer. You can
run it from the following website.

http://epson.sn > Setup

[J You can register several passwords on a wireless router that uses the WEP security type. If several passwords are
registered, check if the first registered password is set on the printer.
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= “Printing a Network Status Sheet” on page 28

= “Connecting to a Computer” on page 17

Message on the Network Environment

Message

Solution

*Multiple network names (SSID) that
match your entered network name (SSID)
have been detected. Confirm network
name (SSID).

The same SSID may be set on several wireless router. Check the settings on
the wireless router, and change the SSID.

The Wi-Fi environment needs to be
improved. Turn the wireless router off and
then turn it on. If the connection does not
improve, see the documentation for the
wireless router.

After moving the printer closer to the wireless router and removing any
obstacles between them, turn off the wireless router. Wait for about 10
seconds, and then turn it on. If it still does not connect, see the
documentation supplied with the wireless router.

*No more devices can be connected.
Disconnect one of the connected devices if
you want to add another one.

Computer and smart devices that can be connected simultaneously are
connected in full in the Wi-Fi Direct (Simple AP) connection. To add another
computer or smart device, disconnect one of the connected devices first.

You can confirm the number of wireless devices which can be connected
simultaneously and the number of connected devices by checking the
network status sheet.

The same SSID as Wi-Fi Direct exists in the
environment. Change the Wi-Fi Direct SSID
if you cannot connect a smart device to the
printer.

On the printer’s control panel, go to Wi-Fi Direct Setup screen and select the
menu to change the setting. You can change the network name following
after DIRECT-XX-. Enter within 32 characters.

Printing a Network Status Sheet

You can check the detailed network information by printing it such as the maximum number of devices you can
connect by Wi-Fi Direct (simple AP).

1. Load papers.

&
2. Hold down the IB button on the printer's control panel for at least five seconds until the power light flashes.
The network status sheet is printed.

Note:

&
If you release the IB button within five seconds before the power light flashes, a network connection report is printed.

Replacing or Adding New Wireless Routers

If the SSID changes due to the replacement of a wireless router, or a wireless router is added and a new network
environment is established, re-set the Wi-Fi settings.
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Related Information

= “Changing the Connection Method to a Computer” on page 29

Changing the Connection Method to a Computer

Using the installer and re-set up in a different connection method.

[ Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.
http://epson.sn

[ Setting up using the software disc (only for the models that come with a software disc and users with Windows
computers with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.

Selecting Change the Connection Methods
Follow the on-screen instructions until the following screen is displayed.

Select Set up Printer connection again (for new network router or changing USB to network, etc.) on the Install
Software screen, and then click Next.
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Install Software
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Restoring the Network Settings from the Control
Panel

You can restore all network settings to their defaults.

1. Turn the printer off.

2. While holding down the @ button, press the O button until the BF light and the kem®  light flash
alternately.
= =
Restoration is complete when the ' light and the kem®  light are off.

INolific
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Preparing the Printer

Loading Papers

Available Paper and Capacities

Note:

The paper size displayed differs depending on the driver.

Genuine Epson Paper

Epson recommends using genuine Epson paper to ensure high-quality printouts.

Note:

The availability of paper varies by location. For the latest information on paper available in your area, contact Epson

support.

Paper suitable for printing documents |:|

Media Name

Size

Loading Capacity (Sheets)

Manual 2-Sided Printing

Epson Bright White Ink Jet
Paper

A4

120

v

*1  For manual 2-sided printing, you can load up to 30 sheets for paper with one side already printed.

Paper suitable for printing documents and Photos m

Heavyweight

Media Name Size Loading Capacity (Sheets) Manual 2-Sided Printing
Epson Photo Quiality Ink Jet A4 100 -

Paper

Epson Matte Paper- A4 20 -
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Commercially Available Paper

Plain papers

Media Name Size Loading Capacity (Sheets) Manual 2-Sided Printing
Plain paper Letter, A4, B5, 16K (195x270 150" v
mm ), A5, A6, B6
Copy paper
High quality plain Legal, Indian-Legal, 8.5%13 1 v
paper in.
User Defined (mm) 1 v
89x127 to 215.9x1200

*1  For manual 2-sided printing, you can load up to 30 sheets for paper with one side already printed.

Envelopes
Media Name Size Loading Capacity Manual 2-Sided Printing
(Envelopes)
Envelope Envelope #10, Envelope DL, 10 v
Envelope C6

Paper Handling Precautions

[d Read the instruction sheets supplied with the paper.

[d To achieve high-quality printouts with genuine Epson paper, use the paper in the environment stated on the
sheets supplied with the paper.

(d Fan and align the edges of the paper before loading. Do not fan or curl photo paper. Doing so may damage the
printable side.

»

[ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled
paper may cause paper jams and smears on the printout.
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[d Do not use paper that is wavy, torn, cut, folded, damp, too thick, too thin, or paper that has stickers stuck to it.
Using these types of paper causes paper jams and smears on the printout.

[J Make sure you are using long-grain paper. If you are not sure what type of paper you are using, check the paper
packaging or contact the manufacturer to confirm the paper specifications.

Related Information

= “Printer Specifications” on page 111

Loading Paper in the Paper Cassette

1.  Open the front cover until it clicks, and then slide out the paper cassette until it stops.

n Important:

The paper cassette cannot be removed.

2. Slide the edge guides to their maximum position.
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3. With the printable side facing down, load paper until it touches the back of the paper cassette.

n Important:

Do not load more than the maximum number of sheets specified for the paper.

1 85x13in.
Load paper using the line.

[ Legal

Pull out the paper guide extension and load paper using the line.
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4. Slide the edge guides to the edges of the paper.

5. Insert the paper cassette as far as it will go.

n Important:

Do not push in the paper after inserting the paper cassette. It may cause a paper feed problem. If the paper is
pushed in, align the paper to the paper size line.

6.
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Related Information

= “Paper Handling Precautions” on page 32
= “Available Paper and Capacities” on page 31
= “List of Paper Type” on page 36

= “Loading Envelopes and Precautions” on page 36

Loading Envelopes and Precautions

Load envelopes with the flap facing up until they touch the back of the paper cassette, and then slide the edge
guides to the edges of the envelopes.

[J Fan and align the edges of the envelopes before loading. When the stacked envelopes are puffed up with air,
press them down to flatten them before loading.

@:&g

[d Do not use envelopes that are curled or folded. Using these envelopes causes paper jams and smears on the
printout.

(4 Do not use envelopes with adhesive surfaces on the flaps or window envelopes.

[J Avoid using envelopes that are too thin, as they may curl during printing.
Related Information

= “Available Paper and Capacities” on page 31
= “Loading Paper in the Paper Cassette” on page 33

List of Paper Type

To obtain optimum printing results, select the paper type that suits the paper.
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Media Name Media Type

Epson Bright White Ink Jet Paper Plain paper

Epson Matte Paper-Heavyweight Epson Matte

Epson Photo Quality Ink Jet Paper Epson Photo Quality Ink Jet

Saving Power

The printer enters sleep mode or turns off automatically if no operations are performed for a set period. You can
adjust the time before power management is applied. Any increase will affect the product's energy efficiency. Please
consider the environment before making any change.

Depending on the location of purchase, the printer may have a feature that turns it oftf automatically if it is not
connected to the network for 30 minutes.

Saving Power - Windows
1. Access the printer driver window.
2. Click Printer and Option Information on the Maintenance tab.

3. Do one of the following.

[ Select the time period before the printer enters sleep mode as the Sleep Timer setting, and click Send. To
make the printer turn off automatically, select the time period as the Power Off Timer setting, and click
Send.

[ Select the time period before the printer enters sleep mode as the Sleep Timer setting, and click Send. To
make the printer turn off automatically, select the time period in the Power Off If Inactive or Power Off If
Disconnected setting, and then click Send.

Note:
Your product may have the Power Off Timer feature or Power Off If Disconnected and Power Off If Disconnected
features depending on the location of purchase.

4. Click OK.

Saving Power - Mac OS

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click Printer Settings.
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4. Do one of the following.

[ Select the time period before the printer enters sleep mode as the Sleep Timer setting, and click Apply. To
make the printer turn off automatically, select the time period as the Power Off Timer setting, and click
Apply.

[ Select the time period before the printer enters sleep mode as the Sleep Timer setting, and click Apply. To
make the printer turn off automatically, select the time period in the Power Off If Inactive or Power Off If
Disconnected setting, and then click Apply.

Note:

Your product may have the Power Off Timer feature or Power Off If Inactive and Power Off If Disconnected features
depending on the location of purchase.
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Printing from the Printer Driver on Windows

Accessing the Printer Driver

When accessing the printer driver from the computer's control panel, the settings are applied to all of the
applications.

Accessing the printer driver from the control panel
(1 Windows 10/Windows Server 2016

Click on the start button, and then select Windows System > Control Panel > View devices and printers in
Hardware and Sound. Right-click on your printer, or press and hold it and then select Printing preferences.

[ Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound. Right-click
on your printer, or press and hold it and then select Printing preferences.

[ Windows 7/Windows Server 2008 R2

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound. Right-
click on your printer and select Printing preferences.

[ Windows Vista/Windows Server 2008

Click the start button, and select Control Panel > Printers in Hardware and Sound. Right-click on your printer
and select Select printing preferences.

(J Windows XP/Windows Server 2003 R2/Windows Server 2003

Click the start button, and select Control Panel > Printers and Other Hardware > Printers and Faxes. Right-
click on your printer and select Printing preferences.

Accessing the printer driver from the printer icon on the task bar
The printer icon on the desktop task bar is a shortcut icon allowing you to quickly access the printer driver.

If you click the printer icon and select Printer Settings, you can access the same printer settings window as the one
displayed from the control panel. If you double-click this icon, you can check the status of the printer.

Note:
If the printer icon is not displayed on the task bar, access the printer driver window, click Monitoring Preferences on the
Maintenance tab, and then select Register the shortcut icon to the taskbar.

Printing Basics

Note:
Operations may differ depending on the application. See the application’s help for details.

1. Open the file you want to print.

Load paper in the printer if it has not already been loaded.
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2. Select Print or Page Setup from the File menu.
3. Select your printer.

4. Select Preferences or Properties to access the printer driver window.

=8 EPSON XXX Series Printing Preferences x
Main  More Options  Maintenance
Printing Presets
Add/Remove Presets. .. Document Size A4 210 % 297 mm w
J:} Document - Fast
:; Document - Standard Quality Orientation (@) Portrait (O Landscape
f_”, Document - High Quality
& pocument - 2-4Up Paper Type Plain paper hd
Quality Standard v
2-Sided Printing | Off e
Settings...
[ ‘_ Multi-Page off ~ Page Order...
j— o - [~
._I R Copies 1 - Colate
— o o Reverse Order
at 2 i 2 1
3 3
Quiet Mode off -
Show Settings |:| Print Preview
[30b Arranger Lite
Reset Defaults Ink Levels
Sancal oo ek

5. Change the settings as necessary.
See the menu options for the printer driver for details.

Note:
[ You can also see the online help for explanations of the setting items. Right-clicking an item displays Help.

[ When you select Print Preview, you can see a preview of your document before printing.
6. Click OK to close the printer driver window.

7. Click Print.

Note:
When you select Print Preview, a preview window is displayed. To change the settings, click Cancel, and then repeat
the procedure from step 2.

Related Information

= “Available Paper and Capacities” on page 31

= “Loading Paper in the Paper Cassette” on page 33
= “Main Tab” on page 54
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Printing on 2-Sides

You can print on both sides of the paper. You can also print a booklet that can be created by re-ordering the pages
and folding the printout.
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Note:
[ Flip the paper over to print on the other side when the printer has finished printing the first side.

1 If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.
[d Depending on the paper and the data, ink may bleed through to the other side of the paper.

Related Information

= “Available Paper and Capacities” on page 31

Print Settings

2-sided printing is available when EPSON Status Monitor 3is enabled. However, it may not be available when the
printer is accessed over a network or is used as a shared printer.

Note:
To enable EPSON Status Monitor 3, click Extended Settings on the Maintenance tab, and then select Enable EPSON
Status Monitor 3.

1. On the printer driver's Main tab, select an option from 2-Sided Printing.

2. Click Settings, make the appropriate settings, and then click OK.
Note:
To print a folded booklet, select Booklet.

3. Click Print.

When the first side has finished printing, a pop-up window is displayed on the computer. Follow the on-screen
instructions.

Related Information

= “Printing Basics” on page 39
= “Main Tab” on page 54
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Printing Several Pages on One Sheet

You can print two or four pages of data on a single sheet of paper.
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Print Settings

On the printer driver's Main tab, select 2-Up or 4-Up as the Multi-Page setting.

Related Information
= “Printing Basics” on page 39
= “Main Tab” on page 54

Printing and Stacking in Page Order (Reverse Order Printing)

You can print from the last page so that the documents are stacked in page order.

| SR

On the printer driver's Main tab, select Reverse Order.

Print Settings

Related Information

= “Printing Basics” on page 39
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= “Main Tab” on page 54

Printing a Reduced or Enlarged Document

You can reduce or enlarge the size of a document by a specific percentage or to fit the paper size you loaded in the
printer.

7
N\ =

Print Settings

On the printer driver's More Options tab, select the document size from the Document Size setting. Select the
paper size you want to print on from the Output Paper setting. Select Reduce/Enlarge Document, and then select
Fit to Page or Zoom to. When you select Zoom to, enter a percentage.

Select Center to print the images in the center of the page.

Related Information
= “Printing Basics” on page 39
= “More Options Tab” on page 54

Printing One Image on Multiple Sheets for Enlargement (Creating a
Poster)

This feature allows you to print one image on multiple sheets of paper. You can create a larger poster by taping

them together.
—

»
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Print Settings

On the printer driver's Main tab, select 2x1 Poster, 2x2 Poster, 3x3 Poster, or 4x4 Poster as the Multi-Page
setting. If you click Settings, you can select the panels that you do not want to print. You can also select the cutting
guide options.

Related Information
= “Printing Basics” on page 39
= “Main Tab” on page 54

Making Posters Using Overlapping Alignment Marks

Here is an example of how to make a poster when 2x2 Poster is selected, and Overlapping Alignment Marks is
selected in Print Cutting Guides.

The actual guides are printed in monochrome, but for this explanation they are shown as blue and red lines.

sheet1I <:> lsheet2

sheet 3 sheet 4
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1. Prepare Sheet 1 and Sheet 2. Cut off the margins of Sheet 1 along the vertical blue line through the center of
the top and bottom cross marks.
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sheet2 H B sheet1 ¥ sheet2 K
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2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets
together from the back.

4 )
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¥ sheet1 sheet2 K
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3. Cut the taped sheets in two along the vertical red line through the alignment markers (this time, the line to the
left of the cross marks).
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4. Tape the sheets together from the back.

= [ =
¥ sheet1 sheet2 K

= ® 034

5. Repeat steps 1 to 4 to tape Sheet 3 and Sheet 4 together.
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6. Cut off the margins of Sheet 1 and Sheet 2 along the horizontal blue line through the center of the left and right
side cross marks.

4 )

B sheet1 sheet2 H
4

PGl - TEEELLY i =2

7. Place the edge of Sheet 1 and Sheet 2 on top of Sheet 3 and Sheet 4 and align the cross marks, and then
temporarily tape them together from the back.

4 )

= 1] ®
¥ sheet1 sheet2 K

..........................

B sheet 3 " sheet 4 uﬂ
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8. Cut the taped sheets in two along the horizontal red line through the alignment markers (this time, the line
above the cross marks).

( )

[>:] [ [>:]

A
= ¥ sheet1 sheet2 H

sheet2 K

4 sheet 3 i sheet 4 :ﬂ g sheet3 sheet4 g

= X B3]

9. Tape the sheets together from the back.

= [ ®
¥ sheet1 sheet2 K

5 sheet 3 i sheet 4 MJE
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10. Cut off the remaining margins along the outer guide.
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Printing with a Header and Footer

You can print information such as a user name and printing date in headers or footers.

(=
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Print Settings

On the printer driver's More Options tab, click Watermark Features, and then select Header/Footer. Click
Settings, and then select the items you want to print.
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Related Information
= “Printing Basics” on page 39
= “More Options Tab” on page 54

Printing a Watermark

You can print a watermark such as "Confidential" on your printouts. You can also add your own watermark.

Note:
This feature is not available with borderless printing.

Print Settings
On the printer driver's More Options tab, click Watermark Features, and then select Watermark. Click Settings

to change details such as the size, density, or position of the watermark.

Related Information
= “Printing Basics” on page 39
= “More Options Tab” on page 54

Printing Multiple Files Together

Job Arranger Lite allows you to combine several files created by different applications and print them as a single
print job. You can specify the print settings for combined files, such as multi-page layout, and 2-sided printing.
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Print Settings

On the printer driver's Main tab, select Job Arranger Lite. When you start printing, the Job Arranger Lite window
is displayed. With the Job Arranger Lite window opened, open the file that you want to combine with the current
file, and then repeat the above steps.
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When you select a print job added to Print Project in the Job Arranger Lite window, you can edit the page layout.
Click Print from the File menu to start printing.

Note:
If you close the Job Arranger Lite window before adding all the print data to the Print Project, the print job you are currently
working on is canceled. Click Save from the File menu to save the current job. The extension of the saved files is "ecl”.

To open a Print Project, click Job Arranger Lite on the printer driver's Maintenance tab to open the Job Arranger Lite
window. Next, select Open from the File menu to select the file.

Related Information
= “Printing Basics” on page 39
= “Main Tab” on page 54

Adjusting the Print Tone

You can adjust the tone used in the print job.

=)
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Note:
These adjustments are not applied to the original data.

Print Settings
On the printer driver's More Options tab, select Custom as the Tone Correction setting. Click Advanced to open
the Tone Correction window, and then select the method of tone correction.

Note:
[d Automatic is selected as default on the More Options tab. This setting automatically adjusts the tone to match the paper
type and print quality settings.

Related Information

= “Printing Basics” on page 39
= “More Options Tab” on page 54
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Printing to Emphasize Thin Lines

You can thicken thin lines that are too thin to print.

=)

Print Settings

On the printer driver's More Options tab, click Image Options in the Tone Correction setting. Select Emphasize
Thin Lines.

Related Information
= “Printing Basics” on page 39
= “More Options Tab” on page 54

Printing to Enhance Light Text and Lines

You can enhance light letters and lines to make them more visible, or to sharpen images.

Print Settings
On the printer driver's More Options tab, click Image Options in the Tone Correction setting. Select Enhance

Light Text and Lines.

Related Information
= “Printing Basics” on page 39
= “More Options Tab” on page 54
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Printing Clear Bar Codes

You can print a bar code clearly and make it easy to scan. Only enable this feature if the bar code you printed

cannot be scanned.

You can use this feature under the following conditions.

01234

(4 Paper: Plain paper, Copy paper, High quality plain paper, or Envelope
(d Quality: Standard

The print quality may be changed when printing. The print speed may become slower and print density may
become higher.

Note:
Deblurring may not always be possible depending on the circumstances.

Print Settings

On the printer driver's Maintenance tab, click Extended Settings, and then select Barcode mode.

Related Information
= “Printing Basics” on page 39
= “Maintenance Tab” on page 55

Canceling Printing

You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.

Canceling

On your computer, right-click on your printer in Devices and Printers, Printer, or in Printers and Faxes. Click
See what's printing, right-click on the job you want to cancel, and then select Cancel.

Menu Options for the Printer Driver

Open the print window in an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.
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Printing Presets

Add/Remove Presets You can add or remove your own presets for frequently used print

settings. Select the preset you want to use from the list.

Show Settings

Displays a list of items currently set on the Main and More Options tabs.

Reset Defaults

Return all settings to their factory default values. The settings on the More Options tab are also
reset to their defaults.

Ink Levels

Displays how to check the ink level.

Paper Source

Select the paper source from which the paper is fed. Select Auto Select to automatically select the
paper source selected in the print settings on the printer.

If the printer has only one paper source, this item is not displayed.

Document Size

Select the paper size on which you want to print. If you select User-Defined, enter the paper width
and height.

Orientation Select the orientation you want to use to print.
Paper Type Select the type of paper on which you print.
Quality Select the pint quality you want to use for printing. Available settings depend on the paper type

you select.

2-Sided Printing

Allows you to perform 2-sided printing.

Settings You can specify the binding edge and the binding margins.

Multi-Page Allows you to print several pages on one sheet or perform poster printing. Click Page Order to
specify the order in which pages are printed.

Copies Set the number of copies you want to print.
Collate Prints multi-page documents collated in order and sorted into sets.
Reverse Order Allows you to print from the last page so that the pages are stacked in the

correct order after printing.
Quiet Mode Reduces the noise the printer makes. However, enabling this may reduce print speed.

Print Preview

Displays a preview of your document before printing.

Job Arranger Lite

Select to print using the Job Arranger Lite feature.

More Options Tab

Printing Presets

You can add or remove your own presets for frequently used print
settings. Select the preset you want to use from the list.

Add/Remove Presets

Show Settings

Displays a list of items currently set on the Main and More Options tabs.

Reset Defaults

Return all settings to their factory default values. The settings on the Main tab are also reset to their
defaults.

Document Size

Select the size of your document.
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Output Paper

Select the paper size on which you want to print. If the Output Paper differs from the Document
Size, Reduce/Enlarge Document is selected automatically. You do not have to select it when
printing without reducing or enlarging the size of a document.

Reduce/Enlarge
Document

Allows you to reduce or enlarge the size of a document.

Fit to Page Automatically reduce or enlarge the document to fit to the paper size
selected in Output Paper.

Zoom to Prints with a specific percentage.
Center Prints images in the center of the paper.
Tone Correction Automatic Adjusts the tone of images automatically.
Custom Allows you to perform manual tone correction. Click Advanced for

further settings.

Image Options Enables print quality options such as Emphasize Text. You can also
thicken thin lines to make them visible on the printouts.

Watermark Features

Allows you to make settings for anti-copy pattern or watermarks.

Additional Settings

Rotate 180° Rotates pages 180 degrees before printing. This feature is helpful when
printing on paper such as envelopes that are loaded in fixed direction in
the printer.

High Speed Prints when the print head moves in both directions. The print speed is

faster, but the quality may decline.

Mirror Image Inverts an image to print as it would appear in a mirror.

Maintenance Tab

Nozzle Check

Prints a nozzle check pattern to check if the print head nozzles are clogged.

Head Cleaning

Cleans the clogged nozzles in the print head. Because this feature uses some ink, clean the print
head only if some nozzles are clogged as shown in the illustration of the nozzle check pattern.
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Power Cleaning

Runs power cleaning to clean the clogged nozzles in the print head. Because this feature uses more
ink than head cleaning, run power cleaning only if most nozzles are clogged as shown in the
illustration of the nozzle check pattern.

Print Head Alignment

Aligns the print head if vertical lines are misaligned.

Paper Guide Cleaning

Cleans the paper path if the printouts are smeared.

Job Arranger Lite Opens the Job Arranger Lite window. Here you can open and edit previously saved data.

EPSON Status Opens the EPSON Status Monitor 3 window. Here you can confirm the status of the printer and the
Monitor 3 consumables.

Monitoring Allows you to make settings for items on the EPSON Status Monitor 3 window.

Preferences

Extended Settings

Allows you to make a variety of settings. Right-click each item to view the Help for more details.

Print Queue

Displays the jobs waiting to be printed. You can check, pause, or resume print jobs.

Printer and Option
Information

Displays the number of sheets of paper fed into the printer.

Language

Changes the language used on the printer driver window. To apply the settings, close the printer
driver, and then open it again.

Software Update

Starts EPSON Software Updater to check for the latest version of applications on the Internet.

Technical Support

Allows you to access the Epson technical support website.

Printing from the Printer Driver on Mac OS

Printing Basics

Note:

Operations differ depending on the application. See the application’s help for details.

1. Open the file you want to print.

Load paper in the printer if it has not already been loaded.

2. Select Print from the File menu or another command to access the print dialog.

If necessary, click Show Details or¥ to expand the print window.

3. Select your printer.
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4. Select Print Settings from the pop-up menu.
Printer: EPSON XXXX ﬂ
Presets: Default Settings [T
Copies: 1
Pages: © All
From: 1 to: |1
Paper Size: A4 ﬁ 210 by 297 mm
Orientation: T H Ts. Scale: 100%
Print Settings B
Paper Source: Auto Select B
Media Type: Plain paper ﬁ
Print Quality: Normal ﬂ
» Advanced Settings:
cancel (TN

Note:
On OS X Mountain Lion or later, if the Print Settings menu is not displayed, the Epson printer driver has not been
installed correctly.

Select System Preferences from the :‘. menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the
printer, and then add the printer again. See the following to add a printer.

http://epson.sn

5. Change the settings as necessary.

See the menu options for the printer driver for details.

6. Click Print.
Related Information
= “Available Paper and Capacities” on page 31

= “Loading Paper in the Paper Cassette” on page 33
= “Menu Options for Print Settings” on page 61
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Printing Several Pages on One Sheet

You can print two or four pages of data on a single sheet of paper.
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Print Settings

Select Layout from the pop-up menu. Set the number of pages in Pages per Sheet, the Layout Direction (page
order), and Border.

Related Information
= “Printing Basics” on page 56
= “Menu Options for Layout” on page 60

Printing and Stacking in Page Order (Reverse Order Printing)

You can print from the last page so that the documents are stacked in page order.

0~

Select Paper Handling from the pop-up menu. Select Reverse as the Page Order setting.

Print Settings

Related Information

= “Printing Basics” on page 56
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= “Menu Options for Paper Handling” on page 60

Printing a Reduced or Enlarged Document

You can reduce or enlarge the size of a document by a specific percentage or to fit the paper size you loaded in the
printer.
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Print Settings

When printing to fit to the paper size, select Paper Handling from the pop-up menu, and then select Scale to fit
paper size. Select the paper size you loaded in the printer in Destination Paper Size. When reducing the size of
the document, select Scale down only.

When printing at a specific percentage, do one of the following.

[ Select Print from the File menu of the application. Select Printer, enter a percentage in Scale, and then click
Print.

[ Select Page Setup from the File menu of the application. Select your printer in Format For, enter a percentage
in Scale, and then click OK.

Note:
Select the paper size you set in the application as the Paper Size setting.

Related Information
= “Printing Basics” on page 56
= “Menu Options for Paper Handling” on page 60

Canceling Printing

You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.
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Canceling

Click the printer icon in the Dock. Select the job you want to cancel, and then do one of the following.

[ OS X Mountain Lion or later

Click next to the progress meter.

[ Mac OS X v10.6.8 to v10.7.x
Click Delete.

Menu Options for the Printer Driver

Open the print window in an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.

Menu Options for Layout

Pages per Sheet Select the number of pages to be printed on one sheet.

Layout Direction Specify the order in which the pages will be printed.

Border Prints a border around the pages.

Reverse page Rotates pages 180 degrees before printing. Select this item when printing on paper such as
orientation envelopes that are loaded in fixed direction in the printer.

Flip horizontally Inverts an image to print as it would appear in a mirror.

Menu Options for Color Matching

ColorSync Select the method for color adjustment. These options adjusts colors between the printer and the

computer display to minimize the difference in color.
EPSON Color Controls

Menu Options for Paper Handling

Collate pages Prints multi-page documents collated in order and sorted into sets.
Pages to Print Select to print only odd pages or even pages.
Page Order Select to print from the top or the last page.

Scale to fit paper size Prints to fit to the paper size you loaded.

Destination Paper Select the paper size to print on.
Size
Scale down only Select when reducing the size of the document.
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Menu Options for Cover Page
Print Cover Page Select whether or not to print a cover page. When you want to add a back cover, select After
document.
Cover Page Type Select the contents of the cover page.
Menu Options for Print Settings
Paper Source Select the paper source from which the paper is fed. If the printer has only one paper source, this

item is not displayed. Selecting Auto Select selects the paper source that matches the paper
setting on the printer automatically.

Media Type Select the type of paper on which you print.
Print Quality Select the pint quality you want to use for printing. The options vary depending on the paper type.
Advanced Settings Adjusts the brightness and the contrast of images.

Making Operation Settings for the Mac OS Printer Driver

Accessing the Operation Settings Window of the Mac OS Printer Driver

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver).

Operation Settings of the Mac OS Printer Driver

(d Skip Blank Page: Avoids printing blank pages.
d Quiet Mode: Prints quietly. However, the print speed may be slower.

[J High Speed Printing: Prints when the print head moves in both directions. The print speed is faster, but the
quality may decline.

[ Warning Notifications: Allows the printer driver to display warning notifications.

[J Establish bidirectional communication: Usually, this should be set to On. Select Off when acquiring the printer
information is impossible because the printer is shared with Windows computers on a network or for any other
reason.

Printing from Smart Devices

Using Epson iPrint

Epson iPrint is an application that allows you to print photos, documents, and web pages from a smart device such
as a smartphone or tablet. You can use local print, printing from a smart device that is connected to the same
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wireless network as your printer, or remote print, printing from a remote location over the Internet. To use remote
print, register your printer in the Epson Connect service.

-E-

EPSON

Related Information

= “Printing Using a Network Service” on page 88

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/c

Printing Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen.

The following screens are subject to change without notice. The contents may vary depending on the product.

seese 7 19:41

LT 7 19:41 2% -

£ Home Photos @'— e

Epson iPrint

Shopping

Camera

Documet Cloud Capture

Copy Memory Card

g

Creative Print | More Apps

Deselect Rotate e
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(1) Home screen displayed when the application is started.

(2] Displays information on how to setup the printer and a FAQ.

(3] Displays the screen where you can select the printer and make printer settings. Once you have selected the
printer, you do not need to select it again from the next time.

(4] Select what you want to print such as photos and documents.

(5] Displays the screen to make print settings such as paper size and paper type.

(6] Displays the paper size. When this is displayed as a button, tap it to display the paper settings currently set
on the printer.

(7] Displays photos and documents you selected.

(3] Starts printing.

Note:
To print from the document menu using iPhone, iPad, and iPod touch running iOS, start Epson iPrint after transferring the
document you want to print using the file sharing function in iTunes.

Using Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet
(Android v4.4 or later). With a few taps, your Android device will discover an Epson printer that is connected to
the same wireless network.

1. Load paper in the printer.

2. Set up your printer for wireless printing.

3. On your Android device, install the Epson Print Enabler plug-in from Google Play.

4. Connect your Android device to the same wireless network as your printer.

5. Go to Settings on your Android device, select Printing, and then enable Epson Print Enabler.

6. From an Android application such as Chrome, tap the menu icon and print whatever is on the screen.

Note:
If you do not see your printer, tap All Printers and select your printer.

Related Information
= “Loading Paper in the Paper Cassette” on page 33

= “Connecting to a Smart Device” on page 18

Canceling Printing - Printer Button

Press the & button to cancel the print job in progress.
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Refilling Ink

Checking the Ink Level

To confirm the actual ink remaining, visually check the ink level in the printer's tank.

Important:

Prolonged use of the printer when the ink level is below the lower line could damage the printer.
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Ink Bottle Codes

Epson recommends the use of genuine Epson ink bottles.

The following are the codes for genuine Epson ink bottles.

g Important:

1 Epson warranty does not cover damage caused by inks other than those specified, including any genuine Epson
ink not designed for this printer or any third party ink.

1 Other products not manufactured by Epson may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic printer behavior.

Note:
[ Ink bottle codes may vary by location. For the correct codes in your area, contact Epson support.

[ Although the ink bottles may contain recycled materials, this does not affect printer function or performance.

[ Specifications and appearance of the ink bottle are subject to change without prior notice for improvement.

For Europe
Product BK: Black
ET-M1120 111
M1120 110%1/1105*2

*1 High capacity / *2 Standard capacity
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Note:
For users in Europe, visit the following website for information on Epson's ink bottle yields.

http://www.epson.eu/pageyield

For Australia and New Zealand

BK: Black

532

For Asian countries except for China

BK: Black

005*1 /0058 *2

*1 High capacity / *2 Standard capacity

Related Information
= “Technical Support Web Site” on page 120

Ink Bottle Handling Precautions

Storing precautions for ink
[ Store ink bottles at normal room temperature and keep them away from direct sunlight.
[d Epson recommends using the ink bottle before the date printed on the package.

[ When storing or transporting an ink bottle, do not tilt the bottle and do not subject it to impacts or temperature
changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink
bottle upright when tightening the cap, and take precautions to prevent ink from leaking when transporting the
bottle, for example, putting the bottle in a bag.

[d After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for at least
three hours before using it.

(d Do not open the ink bottle package until you are ready to fill the ink tank. The ink bottle is vacuum packed to
maintain its reliability. If you leave an ink bottle unpacked for a long time before using it, normal printing may
not be possible.

[d Once you open an ink bottle, we recommend using it as soon as possible.
(4 Epson recommends using the ink bottle before the date printed on the package.

(d For optimum print results do not maintain low ink levels for extended periods of time.

Handling precautions for refilling ink
[d Use ink bottles with the correct part code for this printer.

[ This printer requires careful handling of ink. Ink may splatter when the ink tank is filled or refilled with ink. If
ink gets on your clothes or belongings, it may not come off.

[ If the ink tank is not filled up to the lower line, refill the ink soon. Continued use of the printer when the ink
level is below the lower line on the tank could damage the printer.
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(d To obtain optimum printing results, refill the ink tank to the upper line at least once every year.

(d Do not shake too vigorously or squeeze the ink bottles.

Ink consumption

[ The ink in the ink bottle supplied with your printer is partly used during initial setup. In order to produce high
quality printouts, the print head in your printer will be fully charged with ink. This one-off process consumes a
quantity of ink and therefore this bottle may print fewer pages compared to subsequent ink bottles.

[J Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

Refilling the Ink Tank

Ink can be refilled at any time.

g Important:

Epson recommends the use of genuine Epson ink bottles.

1. Open the printer cover.

K‘ ,E§D/

=%
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3. Check that the ink tank moves to the filling position and aligns with the A mark.

n Important:

Do not put your hand inside the printer until everything has stopped moving.

Note:
To cancel refilling the ink tank, hold down the O button.

4. Open the cap of the ink tank.

5.  While holding the ink bottle upright, turn the cap slowly to remove it.

o

67



User's Guide

Refilling Ink

n Important:

(d Be careful not to spill any ink.

(d Do not touch the top of the ink bottle after removing the cap; otherwise you may be smeared with ink.

6. Position the top of the ink bottle along the slot in front of the filling port, and then stand the bottle slowly to
insert it into the filling port.

n Important:
(A Do not allow the top of the ink bottle to hit against any objects after removing its cap; otherwise ink may
spill.

[ It may be difficult to see inside the ink tank. Refill the ink tank carefully to prevent ink from spilling out
from the ink inlet.
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7. Insert the top of the ink bottle securely into the filling port of the tank to refill the tank with ink.

Ink pours into the tank just by holding the bottle normally without squeezing. The ink flow stops
automatically when the ink is filled to the upper line.

-
A -~
\_
e \
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g Important:
Do not leave the ink bottle inserted; otherwise the bottle may be damaged or ink may leak.

Note:
If the ink does not start flowing into the tank, remove the ink bottle and try reinserting it.

69



User's Guide

Refilling Ink

8.  When you have finished refilling the ink, remove the ink bottle, and then close the cap of the ink tank securely.

Note:
If any ink remains in the ink bottle, tighten the cap and store the bottle upright for later use.

K

9. Close the cap of the ink tank.

4 )

10. Close the printer cover.
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11. Hold down the O button on the printer for at least five seconds until the O light flashes.

© @ 0@@
K /T%_I
T =

Related Information

= “Ink Bottle Codes” on page 64

= “Ink Bottle Handling Precautions” on page 65
= “Ink Spilled” on page 110
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Maintaining the Printer

Preventing the Print Head from Drying

Always use the power button when turning the printer on and off.
Check that the power light is off before you disconnect the power cord.

The ink itself can dry out if it is not covered. Just like placing a cap on a fountain pen or an oil pen to prevent it
from drying, make sure the print head is capped properly to prevent the ink from drying.

When the power cord is unplugged or a power outage occurs while the printer is in operation, the print head may
not be capped properly. If the print head is left as it is, it will dry out causing nozzles (ink outlets) to clog.

In these cases, turn the printer on and off again as soon as possible to cap the print head.

Check if Nozzles are Clogged (Nozzle Check)

If the nozzles are clogged, the printouts become faint or visible banding appears.

When print quality has declined, first use the nozzle check feature to check if the nozzles are clogged.

Check if Nozzles are Clogged (Nozzle Check) - Printer Buttons

1. Load A4-size plain paper in the printer.
2. Press the ) button to turn off the printer.

3. While holding down the & button, press the O button to turn on the printer for at least five seconds until the
power light flashes.

The nozzle check pattern is printed.

Note:
It may take some time to start printing the nozzle check pattern.

4. Examine the printed pattern, and then perform one of the following options depending on the print results.

C)NG
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A

All lines are printed. No further steps are needed.
[d B or close to B: Cleain the print head.

When some nozzles are clogged, perform head cleaning. For details, see the related information below.
4 Cor close to C: Power Clean the print head.

When most lines are broken or most segments are missing, perform head cleaning. For details, see the
related information below.

Related Information

= “Loading Paper in the Paper Cassette” on page 33

= “Cleaning the Print Head (Head Cleaning)” on page 75

= “Power Cleaning the Print Head (Power Cleaning)” on page 76

Check if Nozzles are Clogged (Nozzle Check) - Windows

1.

Load A4-size plain paper in the printer.

Access the printer driver window.

Click Nozzle Check on the Maintenance tab.

Follow the on-screen instructions to print the nozzle check pattern.

Examine the printed pattern, and then perform one of the following options depending on the print results.

=
2
o

C)NG

A:

All lines are printed. No further steps are needed.

[d B or close to B: Cleain the print head.
When some nozzles are clogged, perform head cleaning. For details, see the related information below.
A Cor close to C: Power Clean the print head.

When most lines are broken or most segments are missing, perform head cleaning. For details, see the
related information below.

Related Information

= “Accessing the Printer Driver” on page 39
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= “Loading Paper in the Paper Cassette” on page 33

= “Cleaning the Print Head (Head Cleaning)” on page 75

= “Power Cleaning the Print Head (Power Cleaning)” on page 76

Check if Nozzles are Clogged (Nozzle Check) - Mac OS

1.

Load A4-size plain paper in the printer.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

Click Options & Supplies > Utility > Open Printer Utility.
Click Nozzle Check.
Follow the on-screen instructions to print the nozzle check pattern.

Examine the printed pattern, and then perform one of the following options depending on the print results.

=
2
)

C)NG

A:

All lines are printed. No further steps are needed.

[d B or close to B: Cleain the print head.
When some nozzles are clogged, perform head cleaning. For details, see the related information below.
4 Cor close to C: Power Clean the print head.

When most lines are broken or most segments are missing, perform head cleaning. For details, see the
related information below.

Related Information

= “Loading Paper in the Paper Cassette” on page 33

= “Cleaning the Print Head (Head Cleaning)” on page 75

= “Power Cleaning the Print Head (Power Cleaning)” on page 76
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Cleaning the Print Head (Head Cleaning)

When printouts are faint or visible banding appears, the nozzles are clogged. When print quality has declined, use
the nozzle check feature to check if the nozzles are clogged, and then clean the print head. For details on how to
run the nozzle check, see the related information below.

n Important:
a

Do not open the printer cover or turn off the printer during head cleaning. If the head cleaning is incomplete, you
may not be able to print.

[ Because print head cleaning uses some ink, clean the print head only if quality declines.
(d When ink is low, you may not be able to clean the print head.

[ If print quality has not improved after repeating nozzle check and head cleaning about three times, wait for at
least six hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary.
We recommend to turn off the printer. If print quality has still not improved, contact Epson support.

To prevent the print head from drying out, do not unplug the printer while the power is on.

Cleaning the Print Head - Printer Buttons

Hold the & button down for at least five seconds until the power light starts flashing.

Print head cleaning starts.

Note:

It may take some time to start print head cleaning.

After the power light stops flashing, turn off the printer, run nozzle check, and then check if the print head nozzles
have been un-clogged.

For details on how to run the nozzle check, see the related information below.

Repeat the nozzle check and head cleaning up to three times until all lines are printed correctly.

Related Information
= “Check if Nozzles are Clogged (Nozzle Check)” on page 72

Cleaning the Print Head - Windows
1. Access the printer driver window.
2. Click Head Cleaning on the Maintenance tab.

3. Follow the on-screen instructions.

After the print head cleaning is finished, run Nozzle Check and then check if the print head nozzles have been un-
clogged. For details on how to run the nozzle check, see the related information below.

Repeat the steps up to three times until all lines are printed correctly.
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Related Information
= “Accessing the Printer Driver” on page 39
= “Check if Nozzles are Clogged (Nozzle Check)” on page 72

Cleaning the Print Head - Mac OS

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.
3. Click Head Cleaning.

4. TFollow the on-screen instructions.

After the print head cleaning is finished, run Nozzle Check and then check if the print head nozzles have been un-
clogged. For details on how to run the nozzle check, see the related information below.

Repeat the steps up to three times until all lines are printed correctly.

Related Information
= “Check if Nozzles are Clogged (Nozzle Check)” on page 72

Power Cleaning the Print Head (Power Cleaning)

The power cleaning feature may improve print quality in the following cases.
[d The most nozzles are clogged.
[J You performed the nozzle check and head cleaning three times and then waited for at least six hours without

printing, but print quality still did not improve.

Before running this feature, use the nozzle check feature to check if the nozzles are clogged, read the following
instructions, and then power clean the print head.

n Important:
Make sure that there is enough ink in the ink tank.

Visually check the ink tank is at least a third full. Low ink levels during Power Cleaning could damage the product.

n Important:

An interval of 12 hours is required between each Power Cleaning.

Normally, a single Power Cleaning should resolve the print quality issue within 12 hours. Therefore, to avoid
unnecessary ink usage, you must wait 12 hours before you try it again.
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n Important:

This feature effects the service life of the ink pads. The ink pads reach their capacity earlier by running this feature. If
the ink pads have reached the end of their service life, contact Epson Support to request replacement.

Note:
When the ink levels are insufficient for Power Cleaning, you cannot run this feature. Even in this case, the levels for printing
may remain.

Related Information
= “Check if Nozzles are Clogged (Nozzle Check)” on page 72

Running Power Cleaning - Windows
1. Access the printer driver window.

2. Click Power Cleaning on the Maintenance tab.

3. Follow the on-screen instructions.

Related Information

= “Accessing the Printer Driver” on page 39
= “Check if Nozzles are Clogged (Nozzle Check)” on page 72

Running Power Cleaning - Mac OS

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.
3. Click Power Cleaning.
4. Follow the on-screen instructions.

Related Information
= “Check if Nozzles are Clogged (Nozzle Check)” on page 72

Aligning the Print Head

If you notice a misalignment of vertical lines or blurred images, align the print head.
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Aligning the Print Head - Windows

1. Load four or more sheets of A4-size plain paper in the printer.
2. Access the printer driver window.

3. Click Print Head Alignment on the Maintenance tab.

4. Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette” on page 33
= “Accessing the Printer Driver” on page 39

Aligning the Print Head - Mac OS

1. Load four or more sheets of A4-size plain paper in the printer.

2. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

3. Click Options & Supplies > Utility > Open Printer Utility.
4. Click Print Head Alignment.
5. Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette” on page 33

Cleaning the Paper Path

When the printouts are smeared or scuffed or paper does not feed correctly, clean the roller inside.

n Important:

Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.

Cleaning the Paper Path - Windows
1. Access the printer driver window.
2. Click Paper Guide Cleaning on the Maintenance tab.

3. Follow the on-screen instructions.
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Cleaning the Paper Path - Mac OS X

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.
3. Click Paper Guide Cleaning.

4. TFollow the on-screen instructions.

Cleaning the Paper Path for Paper Feeding Problems

When paper is not fed from paper cassette correctly, clean the roller inside.

1. Turn off the printer by pressing the O button.
2. Unplug the power cord, and then disconnect the power cord.

3. Make sure that the cap of the ink tank is securely closed.

Important:

If the cap of the ink tank is not securely closed, ink may leak.

4. Close the printer cover.
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5. Slide out the paper cassette, and then remove the paper.

6. Stand the printer on its side with the printer's ink tank at the bottom.

=

L~

A Caution:

Be careful not to trap your hand or fingers when standing the printer. Otherwise you may be injured.

n Important:

Do not leave the printer standing for a long time.

7. Dampen a soft cloth with water, wring it out thoroughly, and then wipe the roller while rotating it with the
cloth.

8. Return the printer to its normal position, and then insert the paper cassette.
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9. Connect the power cord.

Checking the Total Number of Pages Fed Through the
Printer

You can check the total number of pages fed through the printer.

Checking the Total Number of Pages Fed Through the Printer -
Printer Buttons

The information is printed together with the nozzle check pattern.

1. Load A4-size plain paper in the printer.
2. Press the ) button to turn off the printer.

3. Turn the printer on while holding the & button down, and then release the buttons when the power light
flashes.

Checking the Total Number of Pages Fed Through the Printer -
Windows

1. Access the printer driver window.

2. Click Printer and Option Information on the Maintenance tab.

Related Information

= “Accessing the Printer Driver” on page 39

Checking the Total Number of Pages Fed Through the Printer - Mac
os

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click Printer and Option Information.
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Network Service and Software
Information

This section introduces the network services and software products available for your printer from the Epson
website or the supplied software disc.

Application for Configuring Printer Operations (Web
Config)

Web Config is an application that runs in a web browser, such as Internet Explorer and Safari, on a computer or
smart device. You can confirm the printer status or change the network service and printer settings. To use the
Web Config, connect the printer and the computer or device to the same network.

The following browsers are supported.

(01 Browser
Windows XP SP3 or later Microsoft Edge, Internet Explorer 8 or later, Firefox”, Chrome”
Mac OS X v10.6.8 or later Safari®, Firefox”, Chrome”
i0S” Safari”
Android 2.3 or later Default browser
Chrome OS” Default browser

* Use the latest version.

Running Web Config on a Web Browser

1. Check the printer's IP address.

&
Press the Iﬂ button to print the network connection report, and then check the printer's IP address.

2. Launch a Web browser from a computer or smart device, and then enter the printer's IP address.
Format:
IPv4: http://the printer's IP address/
Examples:
IPv4: http://192.168.100.201/

Note:
Using the smart device, you can also run Web Config from the maintenance screen of Epson iPrint.

Related Information

= “Using Epson iPrint” on page 61
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Running Web Config on Windows

When connecting a computer to the printer using WSD, follow the steps below to run Web Config.

1. Open the printer list on the computer.

[ Windows 10/Windows Server 2016

Click on the start button, and then select Windows System > Control Panel > View devices and printers in
Hardware and Sound.

[J Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound (or
Hardware).

[ Windows 7/Windows Server 2008 R2

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.

[ Windows Vista/Windows Server 2008

Click the start button, and select Control Panel > Printers in Hardware and Sound.
2. Right-click on your printer and select Properties.

3. Select the Web Service tab and click the URL.

Running Web Config on Mac OS

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies> Show Printer Webpage.

Application for Printing Web Pages (E-Web Print)

E-Web Print is an application that allows you to easily print web pages with various layouts. See the application's
help for details. You can access the help from the E-Web Print menu on the E-Web Print tool bar.

Note:
[d Windows Server operating systems are not supported.

[d Mac OS is not supported.

[d Check for supported browsers and the latest version from the download site.

Starting
When you install E-Web Print, it is displayed in your browser. Click Print or Clip.

Related Information

= “Installing the Latest Applications” on page 85
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Software Update Tools (EPSON Software Updater)

EPSON Software Updater is an application that checks for new or updated software on the internet and installs it.
You can also update the printer's firmware and manual.

Note:
Windows Server operating systems are not supported.

Installing Method
Download EPSON Software Updater from the Epson website.

If you are using a Windows computer and cannot to download it from the website, you can install it from the
supplied software disc.

http://www.epson.com

Starting on Windows
4 Windows 10

Click the start button, and then select Epson Software > EPSON Software Updater.
(d Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[ Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > Epson Software > EPSON Software
Updater.

Note:
You can also start EPSON Software Updater by clicking the printer icon on the task bar on the desktop, and then selecting
Software Update.

Starting on Mac OS
Select Go > Applications > Epson Software > EPSON Software Updater.

Application for Configuring Multiple Devices
(EpsonNet Config)

EpsonNet Config is an application that allows you to set the network interface addresses and protocols. See the
operations guide for EpsonNet Config or the application's help for more details.

Starting on Windows
(1 Windows 10/Windows Server 2016
Click the start button, and then select EpsonNet > EpsonNet Config.
1 Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Enter the application name in the search charm, and then select the displayed icon.
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[ Windows 7/Windows Vista/Windows XP/Windows Server 2008 R2/Windows Server 2008/Windows Server 2003
R2/Windows Server 2003

Click the start button, and select All Programs or Programs > EpsonNet > EpsonNet Config SE > EpsonNet
Config.

Network Service and Software Information

Starting on Mac OS

Go > Applications > Epson Software > EpsonNet > EpsonNet Config SE > EpsonNet Config.

Installing the Latest Applications

Note:
When reinstalling an application, you need to uninstall it first.

1.

3.

4.

Make sure the printer and the computer are available for communication, and the printer is connected to the

Internet.

Start EPSON Software Updater.

The screenshot is an example on Windows.

Epsan Software Updater

New software is available in the table below.

=0 Select your preduct S 3
Essential Product Updates
Software Status Version Sire

€ ¥

Other useful software

Software Status Wersion Size

€ »

Auto update sattings Tatal = - MB
Exit

For Windows, select your printer, and then click ¥ to check for the latest available applications.

Select the items you want to install or update, and then click the install button.

g Important:

Do not turn off or unplug the printer until the update is complete; otherwise, the printer may malfunction.
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Note:
[ You can download the latest applications from the Epson website.

http://www.epson.com

A If you use Windows Server operating systems, you cannot use EPSON Software Updater. Download the latest
applications from the Epson website.

Related Information
= “Software Update Tools (EPSON Software Updater)” on page 84
= “Uninstalling Applications” on page 86

Updating Applications and Firmware

You may be able to clear certain problems and improve or add functions by updating the applications and the
firmware. Make sure you use the latest version of the applications and firmware.

1. Make sure that the printer and the computer are connected, and the computer is connected to the internet.

2. Start EPSON Software Updater, and update the applications or the firmware.

g Important:

Do not turn off the computer or the printer until the update is complete; otherwise, the printer may
malfunction.

Note:
If you cannot find the application you want to update in the list, you cannot update using the EPSON Software
Updater. Check for the latest versions of the applications from your local Epson website.

http://www.epson.com

Uninstalling Applications

Log in to your computer as an administrator. Enter the administrator password if the computer prompts you.

Uninstalling Applications - Windows

1. Press the ©) button to turn off the printer.
2. Quit all running applications.

3. Open Control Panel:
[ Windows 10/Windows Server 2016

Click on the start button, and then select Windows System > Control Panel.

[J Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012
Select Desktop > Settings > Control Panel.
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[ Windows 7/Windows Vista/Windows XP/Windows Server 2008 R2/Windows Server 2008/Windows Server
2003 R2/Windows Server 2003

Click the start button and select Control Panel.

Open Uninstall a program (or Add or Remove Programs):

[d Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista/Windows Server 2016/Windows Server
2012 R2/Windows Server 2012/Windows Server 2008 R2/Windows Server 2008

Select Uninstall a program in Programs.

[ Windows XP/Windows Server 2003 R2/Windows Server 2003
Click Add or Remove Programs.

Select the application you want to uninstall.

You cannot uninstall the printer driver if there is any print jobs. Delete or wait to be printed the jobs before
uninstalling.

Uninstall the applications:

[d Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista/Windows Server 2016/Windows Server
2012 R2/Windows Server 2012/Windows Server 2008 R2/Windows Server 2008

Click Uninstall/Change or Uninstall.
[ Windows XP/Windows Server 2003 R2/Windows Server 2003

Click Change/Remove or Remove.

Note:
If the User Account Control window is displayed, click Continue.

Follow the on-screen instructions.

Uninstalling Applications - Mac OS

1.

Download the Uninstaller using EPSON Software Updater.

Once you have downloaded the Uninstaller, you do not need to download it again each time you uninstall the
application.

Press the () button to turn off the printer.

To uninstall the printer driver, select System Preferences from the ‘ menu > Printers & Scanners (or Print
& Scan, Print & Fax), and then remove the printer from the enabled printers list.

Quit all running applications.
Select Go > Applications > Epson Software > Uninstaller.

Select the application you want to uninstall, and then click Uninstall.

n Important:

The Uninstaller removes all drivers for Epson inkjet printers on the computer. If you use multiple Epson inkjet
printers and you only want to delete some drivers, delete all of them first, and then install the necessary printer
driver again.
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Note:

If you cannot find the application you want to uninstall in the application list, you cannot uninstall using the
Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you want to uninstall,
and then drag it to the trash icon.

Related Information
= “Software Update Tools (EPSON Software Updater)” on page 84

Printing Using a Network Service

By using Epson Connect service available on the Internet, you can print from your smartphone, tablet PC, or
laptop, anytime and practically anywhere. To use this service, you need to register the user and the printer in
Epson Connect.

The features available on the Internet are as follows.

[ Email Print

When you send an email with attachments such as documents or images to an email address assigned to the
printer, you can print that email and the attachments from remote locations such as your home or office printer.

(A Epson iPrint

This Application is for iOS and Android, and allows you to print from a smart phone or tablet. You can print
documents, images, and websites by sending them directly to a printer on the same wireless LAN.

[ Remote Print Driver

This is a shared driver supported by Remote Print Driver. When printing using a printer in a remote location,
you can print by changing the printer on the usual applications window.

See the Epson Connect portal website for details.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)
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Solving Problems

Checking the Printer Status

Lights and Printer Status

Lights on the control panel indicate the status of the printer.

\© 960 O]

Normal Status

. on

Light Status
@ I:I The printer is connected to a wireless (Wi-Fi) network.
L]
’r,;;‘ D The printer is connected to a network in Wi-Fi Direct (Simple AP) mode.
Error Status

When an error occurs, the light turns on or flashes. Details of the error are displayed on the computer screen.

|:|/ D: On
I:I / I:I: Flashing

Light

Status

Solutions

el &

Wi-Fi connection error has occurred.

Press the Wi-Fi button to clear the error and try again.

0o

Initial ink charging may not be complete.

See the Start Here poster to complete initial ink
charging.

Ink refilling may not be complete.

Refill the ink inside the ink tank, and then press the O
button to return the tank to the home position.

0o

Ink tank cap is not fully closed.

Push in the cap firmly, and then press the O button.

e

No paper is loaded or more than one sheet
has been fed at a time.

Load paper and press the @ button.
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Light

Status

Solutions

A paper jam has occurred.

Remove the paper and press the @ button.

IgE

Protective material may be inside the printer.

Open the printer cover, remove the protective
material, and then press the @ button.

16 00

(1 The printer was not turned off correctly.*

(1 Because the printer was turned off while
operating, the nozzles may have dried
and clogged.

* The power was turned off with a power
strip or breaker, the plug was pulled out of
the outlet, or an electrical failure occurred.

(1 After clearing the error by pressing the @ button,
we recommend performing a nozzle check. Cancel
any pending print jobs.

d To turn off the printer, make sure you press the Q)
button.

16 00

When the O light and the K light flash
simultaneously

An ink pad is nearing or at the end of its
service life.

The ink pads need to be replaced.

Contact Epson or an authorised Epson service

provider to replace the ink pad *. It is not a user-
serviceable part.

When a message saying that you can continue

printing is displayed on the computer, press the V)
button to continue printing. The lights stop flashing
for the time being, however, they will continue to
flash at regular intervals until the ink pad is replaced.

The printer has started in recovery mode
because the firmware update failed.

Follow the steps below to try to update the firmware
again.

1. Connect the computer and the printer with a USB
cable. (During recovery mode, you cannot update the
firmware over a network connection.)

2. Visit your local Epson website for further
instructions.

A printer error has occurred.

Open the front cover and remove any paper inside
the printer. Turn the power off and on again.

If the error continues to occur after turning the power
off and on again, contact Epson support.

*1 In some print cycles a very small amount of surplus ink may be collected in the ink pad. To prevent ink leakage
from the pad, the printer is designed to stop printing when the pad has reached its limit. Whether and how often
this is required will vary according to the number of pages you print, the type of material that you print and the
number of cleaning cycles that the printer performs. The need for replacement of the pad does not mean that your
printer has ceased to operate in accordance with its specifications. The printer will advise you when the pad
requires replacing and this can only be performed by an authorised Epson Service provider. The Epson warranty
does not cover the cost of this replacement.

Related Information

= “Removing Jammed Paper” on page 91

= “Contacting Epson Support” on page 120

= “Installing the Latest Applications” on page 85
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Checking the Printer Status - Windows

1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab.

Note:

(A You can also check the printer status by double-clicking the printer icon on the taskbar. If the printer icon is not
added to the taskbar, click Monitoring Preferences on the Maintenance tab, and then select Register the shortcut
icon to the taskbar.

[d If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.

Related Information

= “Accessing the Printer Driver” on page 39

Checking the Printer Status - Mac OS

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

You can check the printer status, ink levels, and error status.

Checking the Software Status

You may be able to clear the problem by updating the software to the latest version. To check the software status,
use the software update tool.

Related Information
= “Software Update Tools (EPSON Software Updater)” on page 84
= “Installing the Latest Applications” on page 85

Removing Jammed Paper

Check the error displayed on the control panel and follow the instructions to remove the jammed paper including
any torn pieces. Next, clear the error.

n Important:

(A Remove the jammed paper carefully. Removing the paper vigorously may cause damage to the printer.

[ When removing jammed paper, avoid tilting the printer, placing it vertically, or turning it upside down;
otherwise ink may leak.
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Related Information

= “Lights and Printer Status” on page 13

Removing Jammed Paper from Inside the Printer

A Caution:

Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating, it
could cause an injury. Be careful not to touch the protruding parts to avoid injury.

1. Open the printer cover.
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n Important:

Do not touch the white flat cable or translucent film inside the printer. Doing so may cause a malfunction.

3. Close the printer cover.

Removing Jammed Paper from Rear Cover

1. Remove the rear cover.
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2. Remove the jammed paper.

3. Remove jammed paper from the rear cover.

st
.

4. Insert the rear cover in the printer.

Paper Does Not Feed Correctly

Check the following points, and then take the appropriate actions to solve the problem.

[d Place the printer on a flat surface and operate in the recommended environmental conditions.
[d Use paper supported by this printer.

(d Follow the paper handling precautions.

(4 Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load
above the line indicated by the triangle symbol on the edge guide.

Related Information

= “Environmental Specifications” on page 114
= “Paper Handling Precautions” on page 32
= “Available Paper and Capacities” on page 31
= “List of Paper Type” on page 36

Paper Jams

Load paper in the correct direction, and slide the edge guides against the edges of the paper.
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Related Information
= “Removing Jammed Paper” on page 91

= “Loading Paper in the Paper Cassette” on page 33

Paper Feeds at a Slant

Load paper in the correct direction, and slide the edge guides against the edges of the paper.

Related Information

= “Loading Paper in the Paper Cassette” on page 33

Several Sheets of Paper are Fed at a Time

[ When several sheets of paper are fed at a time during manual 2-sided printing, remove any paper which is
loaded in the printer before you reload the paper.

[ If the paper is pushed in, align the paper to the paper size line on the paper cassette.

Power and Control Panel Problems

Power Does Not Turn On
[d Make sure the power cord is securely plugged in.

O Hold down the O button for a little longer.

Power Does Not Turn Off

Hold down the O button for a little longer. If you still cannot turn off the printer, unplug the power cord. To
prevent the print head from drying out, turn the printer back on and turn it off by pressing the O button.

Power Turns Off Automatically

J Windows

Click Printer and Option Information on the printer driver's Maintenance tab.
(J Disable the Power Off If Inactive and Power Off If Disconnected settings.
(J Disable the Power Off Timer setting.
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1 Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Utility > Open Printer Utility, and then click Printer Settings.

J Disable the Power Off If Inactive and Power Off If Disconnected settings.

J Disable the Power Off Timer setting.
Note:

Your product may have the Power Off Timer feature or Power Off If Inactive and Power Off If Disconnected features
depending on the location of purchase.

Cannot Print from a Computer

Checking the Connection (USB)

[d Connect the USB cable securely to the printer and the computer.
[ If you are using a USB hub, try to connect the printer directly to the computer.
[ If the USB cable cannot be recognized, change the port, or change the USB cable.

[ If the printer cannot print using a USB connection, try the following.

Disconnect the USB cable from the computer. Right-click on the printer icon displayed on the computer, and
then select Remove Device. Next, connect the USB cable to the computer and try a test print.

Re-set the USB connection by following the steps in this manual for changing the connection method to a
computer. See the related information link below for details.

~ Printers (19)
o~ - 7
| Open
KHKXX Series | Open in new window b :
See what's printing
e Set as default printer
— Printing preferences -
: N Printer properties ,
Create shortcut
EPSON [ 2 [ E
woooooxd ) Remove device I «
Series | roubleshoo
Properties
- -
XXXKX Series Manufacturer:  Seib
- Model: XX
- Description: Eps

Related Information

= “Changing the Connection Method to a Computer” on page 29

Checking the Connection (Network)

[d When you have changed your access point or provider, try making network settings for the printer again.
Connect the computer or smart device to the same SSID as the printer.

926



User's Guide

Solving Problems

[ Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn on the
devices in the following order; access point, computer or smart device, and then printer. Move the printer and
computer or smart device closer to the access point to help with radio wave communication, and then try to
make network settings again.

[ Print the network connection report. See the related information link below for details. If the report shows that
the network connection failed, check the network connection report and then follow the printed solutions.

[ If the IP address assigned to the printer is 169.254.XXX. XXX, and the subnet mask is 255.255.0.0, the IP address
may not be assigned correctly. Restart the access point or reset the network settings for the printer. If this does
not solve the problem, see the documentation for the access point.

(d Try accessing any website from your computer to make sure that your computer's network settings are correct.
If you cannot access any website, there is a problem on the computer. Check the network connection of the
computer.

Related Information
= “Connecting to a Computer” on page 17
= “Printing a Network Connection Report” on page 22

Checking the Software and Data

[d Make sure that a genuine Epson printer driver is installed. If a genuine Epson printer driver is not installed, the
available functions are limited. We recommend using a genuine Epson printer driver. See the related
information link below for details.

[ If you are printing a large data size image, the computer may run out of memory. Print the image at a lower
resolution or a smaller size.

Related Information
= “Checking for Genuine Epson Printer Drivers” on page 97
= “Installing the Latest Applications” on page 85

Checking for Genuine Epson Printer Drivers

You can check if a genuine Epson printer driver is installed on your computer by using one of the following
methods.

Windows

Select Control Panel > View devices and printers (Printers, Printers and Faxes), and then do the following to
open the print server properties window.

[ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Server 2016/Windows Server 2012 R2/Windows
Server 2012/Windows Server 2008 R2

Click the printer icon, and then click Print server properties at the top of the window.

[ Windows Vista/Windows Server 2008

Right-click on the Printers folder, and then click Run as administrator > Server Properties.

[ Windows XP/Windows Server 2003 R2/Windows Server 2003

From the File menu, select Server Properties.
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Click the Driver tab. If your printer name is displayed in the list, a genuine Epson printer driver is installed on
your computer.

& Devices and Printers

« « 4 x> Control Panel + Hardware and Sound > Devices and Printers * ve

Fle Edit View Tools Help

Piflodzie Gdfloprim Smofmieprmees Fammmisies

v Printers (19) 8 Print Server Properties X
Foms pmecw avancad
- -
<N ;' HRXXKKNHNHXK
L
XXXXX Series
Installed printer drivers:
e
Ty MName Processor Type &
— EPSON X3OXXXX Series 3 - User Mode
EPSON
OO
Series
-
XXX
-
——
v
Add... Remove... Properties
O Change Driver Settings
Sance oy
Mac OS

Select System Preferences from the :‘. menu > Printers & Scanners (or Print & Scan, Print & Fax), and then

select the printer. Click Options & Supplies, and if the Options tab and Utility tab are displayed on the window, a
genuine Epson printer driver is installed on your computer.

Printers & Scanners

General Supply Levels| mmw |

Open Printer Utility
Print Test Page

Clean Print Heads

concel_ (N

Related Information

= “Installing the Latest Applications” on page 85
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Checking the Printer Status from the Computer (Windows)

Click Print Queue on the printer driver's Maintenance tab, and then check the following.

# EFSON COCOD0OCK Printing Preferences x

Min  Mes Optins Msntenance

- &) smonsmsarecn

E— )

@ 3ob Arranger Lie %| Frinter and Opson Enformation
Langrusge Bust Select - W softare Lpdate
e Techrical Suppert

ok Conael ¢ Hep

[ Check if there are any paused print jobs.
If unnecessary data remains, select Cancel all documents from the Printer menu.
[d Make sure the printer is not offline or pending.

If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

[d Make sure the printer is selected as the default printer from the Printer menu (there should be a check mark on
the menu item).

If the printer is not selected as the default printer, set it as the default printer. If there are multiple icons in
Control Panel > View devices and printers (Printers, Printers and Faxes), see the following to select the icon.

Example)
USB connection: EPSON XXXX Series
Network connection: EPSON XXXX Series (network)

If you install the printer driver multiple times, copies of printer driver may be created. If copies such as "EPSON
XXXX Series (copy 1)" are created, right-click the copied driver icon, and then click Remove Device.

[d Make sure the printer port is selected correctly in Property > Port from the Printer menu as follows.

Select "USBXXX" for a USB connection, or "EpsonNet Print Port" for a network connection.

Checking the Printer Status from the Computer (Mac OS)

Make sure the printer status is not Pause.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
double-click the printer. If the printer is paused, click Resume (or Resume Printer).
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When You Cannot Make Network Settings

(d Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn on the
devices in the following order; wireless router, computer or smart device, and then printer. Move the printer and
computer or smart device closer to the wireless router to help with radio wave communication, and then try to
make network settings again.

&
[ Press the @ button to print the network connection report. Check it and then follow the printed solutions.

Cannot Connect from Devices Even Though Network Settings are
No Problems

If you cannot connect from the computer or smart device to the printer even though the network connection
report does not show any problems, see the following.

[d When you are using multiple wireless routers at the same time, you may not be able to use the printer from the
computer or smart device depending on the settings of the wireless routers. Connect the computer or smart
device to the same wireless router as the printer.

Disable the tethering function on the smart device if it is enabled.

(J You may not be able to connect to the wireless router when the wireless router has multiple SSIDs and devices
are connected to different SSIDs on the same wireless router. Connect the computer or smart device to the same
SSID as the printer.

//-; "\

A SSIDT:XXXXX-G1 N SSIDTXXXXX-G1
— SSID2:XXXXX-G2 i SSID2:XXXXX-G2
— % =>

N
D e EPSON
SSIDT:XXXXX-G1 SSID2:XXXXX-G2 SSID2:XXXXX-G2
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[d A wireless router that is compliant with both IEEE802.11a and IEEE802.11g has SSIDs of 2.4 GHz and 5 GHz. If
you connect the computer or smart device to a 5 GHz SSID, you cannot connect to the printer because the
printer only supports communication over 2.4 GHz. Connect the computer or smart device to the same SSID as
the printer.

%
N

-
) 5GHz SSID:XXXXX_A £~
— 2.4GHz SSID:XXXXX_G - 2.4GHz SSID:XXXXX_G

0
i
3
v
i
0

= ~ /rf-
e EPSON e EPSON
= = [ ]
SSID:XXXXX_A SSID:XXXXX_G SSID:XXXXX_G

[J Most wireless routers have a privacy separator feature that blocks communication between connected devices. If
you cannot communicate between the printer and the computer or smart device even if they are connected to
the same network, disable the privacy separator on the wireless router. See the manual provided with the
wireless router for details.

ON

”ﬂ“ég‘/gi\gg

=

Related Information
= “Checking the SSID Connected to the Printer” on page 103
= “Checking the SSID for the Computer” on page 103

When You Cannot Connect Using Wi-Fi Direct (Simple AP)
Connection

If the maximum number of devices have already been connected, you cannot connect any more devices. See the
following and try to re-connect.

Check how many devices are connected

Check how many devices are connected to the printer. If the number of connected devices has not exceeded the
maximum, a connection error may have occurred. Move the printer and computer or smart device closer to the
wireless router to help with radio wave communication, check that the SSID and password are correct, and then
try to make network settings again.
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[ Network status sheet

<Wi=-Fi Direct>»
Wi-Fi Direct Hode
Comsmnication Mode
Operation Mode
Communication Speed
S5ID

Password

Channel

Security Level
Link Statuns

Solving Problems

oo

Simple AP
IEEEB0O2.11g/n
AUto

DIRECT=-

11
WPAZ-PSK(AES)

1in EFrsasrn

i-l:l:tnne-:ted Devices

2(Max 1) |

rdaTie WYY iok

(d Product status screen for Web Config

TS EEECH = H L |
20:02:AF:C1:92:68B

Launch a web browser from the connected device, and then enter the IP address for Wi-Fi Direct (Simple AP) to
open Web Config. Tap Product Status > Wi-Fi Direct and check the Wi-Fi Direct status.

i
L3

__._g.-J Product Status
Basic Network
Device Mame : EPSOM.
Connection Method : Simple AP
IP Address :
Subnet Mask : 255.255.255.0

Default Gateway :

The number of connected d 1

evices :
SSID : DIRECT-
Channel : 1
Security Level : WPA2-PSK(AES)
Password : e
MAC Address :
g O L]

Disconnect unnecessary devices

If the maximum number of devices have already been connected to the printer, disconnect the unnecessary devices

and try to connect the new device.

Delete the SSID for Wi-Fi Direct on the Wi-Fi screen for the device that you do not need to connect to the printer.
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Related Information
= “Printing a Network Status Sheet” on page 28
= “Application for Configuring Printer Operations (Web Config)” on page 82

Checking the SSID Connected to the Printer

You can check the SSID by printing a network connection report, network status sheet, or on Web Config.

Checking the SSID for the Computer

Windows

Click (17 in the task tray on the desktop. Check the name of the connected SSID from the list displayed.
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Mac OS

Click the Wi-Fi icon at the top of the computer screen. A list of SSIDs is displayed and the connected SSID is
indicated with a check mark.

Y = Eicy

Turn Wi-Fi OR
o

i
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Printout Problems

Printout is Scuffed or Color is Missing

If you have not used the printer for a long time, the print head nozzles may be clogged and ink drops may not be
discharged. Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

Related Information

= “Check if Nozzles are Clogged (Nozzle Check)” on page 72
= “Refilling the Ink Tank” on page 66

Banding Appears

!!__' 'lijli“
. = f_"- LT
ol i

The print head nozzles may be clogged. Perform a nozzle check to check if the print head nozzles are clogged.
Clean the print head if any of the print head nozzles are clogged.

Related Information
= “Check if Nozzles are Clogged (Nozzle Check)” on page 72
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Colored Banding Appears at Intervals of Approximately 2.5 cm

[ Select the appropriate paper type setting for the type of paper loaded in the printer.
(d Align the print head from a computer.
(d When printing on plain paper, print using a higher quality setting.

Related Information
= “List of Paper Type” on page 36
= “Aligning the Print Head” on page 77

Vertical Banding or Misalignment

THN&Aaneil anc

y Aunfdruck. W
{5008 "Regel

([ Align the print head.
[ If print quality does not improve even after aligning the print head, print using a higher quality setting.

Related Information
= “Aligning the Print Head” on page 77

Print Quality is Poor

Check the following if the print quality is poor due to blurry prints, banding, missing colors, faded colors, and
misalignment in the prints.

Checking the printer

[J Make sure the initial ink charging is complete.
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[ Refill the ink tank if the ink level is below the lower line.
[d Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

(J Align the print head.

Checking the paper

[d Use paper supported by this printer.

(d Do not print on paper that is damp, damaged, or too old.
[ If the paper is curled or the envelope is puffed up, flatten it.
(4 Do not stack the paper immediately after printing.

[ Dry the printouts completely before filing or displaying them. When drying the printouts, avoid direct sun light,
do not use a dryer, and do not touch the printed side of paper.

(d When printing images or photos, Epson recommends using genuine Epson paper rather than plain paper. Print
on the printable side of the genuine Epson paper.

Checking the print settings

[ Select the appropriate paper type setting for the type of paper loaded in the printer.

[ Print using a higher quality setting.

[d During bidirectional (or high speed) printing, the print head prints while moving in both directions, and
vertical lines may be misaligned. If print quality does not improve, disable the bidirectional (or high speed)
setting. Disabling this setting may slow down printing speed.

(J Windows
Clear High Speed on the printer driver’s More Options tab.

[d Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the High Speed
Printing setting.

Checking the ink bottle
(4 Use ink bottles with the correct part code for this printer.
(4 Epson recommends using the ink bottle before the date printed on the package.

(d Try to use genuine Epson ink bottles. This product is designed to adjust colors based on the use of genuine
Epson ink bottles. The use of non-genuine ink bottles may cause print quality to decline.

Related Information

= “Check if Nozzles are Clogged (Nozzle Check)” on page 72
= “Aligning the Print Head” on page 77

= “Available Paper and Capacities” on page 31

= “List of Paper Type” on page 36

= “Paper Handling Precautions” on page 32
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Paper Is Smeared or Scuffed

[d When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the correct
direction and slide the edge guides to the edges of the paper.

e 4

[ When vertical banding appears or the paper is smeared, clean the paper path.

|V

[ Place the paper on a flat surface to check if it is curled. If it is, flatten it.

[ When printing on thick paper, the print head is close to the printing surface and the paper may be scuffed. In
this case, enable the reduce scuff setting. If you enable this setting, print quality may decline or printing may
slow down.

Windows

Click Extended Settings on the printer driver's Maintenance tab, and then select Short Grain Paper.

[ When performing manual 2-sided printing, make sure that the ink is completely dry before reloading the paper.

Related Information
= “Loading Paper in the Paper Cassette” on page 33
= “Cleaning the Paper Path” on page 78

Printed Photos are Sticky

You may be printing on the wrong side of the photo paper. Make sure you are printing on the printable side.

When printing on the wrong side of the photo paper, you need to clean the paper path.

Related Information

= “Cleaning the Paper Path” on page 78

The Position, Size, or Margins of the Printout Are Incorrect

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.

[ Select the appropriate paper size setting.
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(d Adjust the margin setting in the application so that it falls within the printable area.

Related Information
= “Loading Paper in the Paper Cassette” on page 33
= “Printable Area” on page 111

Printed Characters Are Incorrect or Garbled

[d Connect the USB cable securely to the printer and the computer.
[d Cancel any paused print jobs.

4 Do not put the computer manually into the Hibernate mode or the Sleep mode while printing. Pages of garbled
text may be printed next time you start the computer.

[ If you use the printer driver you had previously used, printed characters may be garbled. Make sure that the
printer driver you are using is for this printer. Check the printer name on the top of the printer driver window.

The Printed Image Is Inverted

Clear any mirror image settings in the printer driver or the application.

J Windows

Clear Mirror Image on the printer driver's More Options tab.

1 Mac OS

Clear Mirror Image from the print dialog's Print Settings menu.

Mosaic-Like Patterns in the Prints

When printing images or photos, print using high-resolution data. Images on websites are often low resolution
although they look good enough on the display, and so print quality may decline.

The Printout Problem Could Not be Cleared

If you have tried all of the solutions and have not solved the problem, try uninstalling and then reinstalling the
printer driver.

Related Information

= “Uninstalling Applications” on page 86
= “Installing the Latest Applications” on page 85
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Other Printing Problems

Printing Is Too Slow

[d Close any unnecessary applications.
[d Lower the quality setting. High quality printing slows down the printing speed.

[d Enable the bidirectional (or high speed) setting. When this setting is enabled, the print head prints while
moving in both directions, and the printing speed increases.

J Windows
Select High Speed on the printer driver's More Options tab.
J Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as the High Speed
Printing setting.

[d Disable quiet mode. This feature slows down the printing speed.

J Windows
Select Off as the Quiet Mode setting on the printer driver's Main tab.

[d Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the Quiet Mode
setting.

Printing Slows Down Dramatically During Continuous Printing

Printing slows down to prevent the printer mechanism from overheating and being damaged. However, you can
continue printing. To return to normal printing speed, leave the printer idle for at least 30 minutes. Printing speed
does not return to normal if the power is off.

Other Problems

Slight Electric Shock when Touching the Printer

If many peripherals are connected to the computer, you may feel a slight electric shock when touching the printer.
Install a ground wire to the computer that is connected to the printer.

Operation Sounds Are Loud

If operations sounds are too loud, enable Quiet Mode. Enabling this feature may reduce printing speed.

(d Windows printer driver
Select On as the Quiet Mode setting on the Main tab.
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(d Mac OS printer driver

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select On as the Quiet Mode setting.

Application Is Blocked by a Firewall (for Windows Only)

Add the application to the Windows Firewall allowed program in security settings on the Control Panel.

Ink Spilled

[ If ink adheres to the area around the tank, wipe it off using a napless, clean cloth or cotton swab.

(1 If ink spills on the desk or floor, wipe it off immediately. When ink is dried, it will be difficult to remove the
smear. To prevent the smear from spreading, blot the ink with a dry cloth, and then wipe it with a moist cloth.

[ If ink gets on your hands, wash them with water and soap.

110



User's Guide

Appendix

Technical Specifications

Printer Specifications

Print Head Nozzle Placement

Weight of Paper”

Plain Paper

*

Black ink nozzles: 180x2 rows
Envelopes

64 to 90 g/m*(17 to 24lb)

Envelope #10, DL, C6: 75 to 90 g/m’ (20 to 24 Ib)
depending on the paper properties or quality.

Printable Area

Even when the paper thickness is within this range, the paper may not feed in the printer or the print quality may decline

Printable Area for Single Sheets

Print quality may decline in the shaded areas due to the printer's mechanism
AH Zc A 3.0mm (0.121n.)
B 3.0mm (0.12in.)
C 41.0mm (1.61in.)
D 37.0mm (1.46in.)
At it
H H
B B
Printable Area for Envelopes
Print quality may decline in the shaded areas due to the printer's mechanism.
AH IC A 3.0 mm (0.121in.)
B 5.0 mm (0.20in.)
C 18.0mm (0.711n))
Af4' ;[D D 41.0mm (161in)
B B
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Interface Specifications
For Computer Hi-Speed USB
Network Function List
Network Functions and IPv4/IPv6
Functions Supported Remarks
Network Printing EpsonNet Print (Windows) IPv4 v -
Standard TCP/IP (Windows) IPv4, IPv6 v -
WSD Printing (Windows) IPv4, IPv6 v Windows Vista or
later
Bonjour Printing (Mac OS) IPv4, IPv6 v -
IPP Printing (Windows, Mac IPv4, IPv6 - -
05s)
UPnP Printing IPv4 - Information
appliance
PictBridge Printing (Wi-Fi) IPv4 - Digital camera
Epson Connect (Email Print, IPv4 v -
Remote Print)
Google Cloud Print IPv4, IPv6 v -
Network Scanning Epson Scan 2 IPv4, IPv6 - -
Event Manager IPv4 - -
Epson Connect (Scan to IPv4 - -
Cloud)
ADF (2-sided scanning) - -
Fax Send a fax IPv4 - -
Receive a fax IPv4 - -

Wi-Fi Specifications

Standards

IEEE802.11b/g/n™"

Frequency Range

24 GHz

Transmitted

Maximum Radio-Frequency Power

20 dBm (EIRP)

Coordination Modes

Infrastructure, Wi-Fi Direct (Simple AP)*2"3
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Wireless Securities ™

WEP (64/128bit), WPA2-PSK (AES)"

*1  |EEE802.11n is only available for the HT20.

*2  Not supported for IEEE 802.11b.

*3  Simple AP mode is compatible with a Wi-Fi connection (infrastructure).

*4  Wi-Fi Direct supports WPA2-PSK (AES) only.

*5  Complies with WPA2 standards with support for WPA/WPA2 Personal.

Security Protocol

SSL/TLS

HTTPS Server/Client

Supported Third Party Services

Google Cloud Print

Dimensions

Dimensions

Storage

d Width: 375 mm (14.8in.)
[ Depth:267 mm (10.5in.)
[ Height: 161 mm (6.3 in.)

Printing

1 Width: 375 mm (14.8in.)
[ Depth:512 mm (20.2in.)
[ Height: 161 mm (6.3 in.)

Weight”

Approx. 3.5 kg (7.7 Ib)

* Without the ink and the power cord.

Electrical Specifications

Model 100 to 240 V Model 220 to 240V Model
Rated Frequency Range 50 to 60 Hz 50 to 60 Hz
Rated Current 04t00.2A 0.2A
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Power Consumption (with USB Con- Printing: Approx. 14.0 W (ISO/ Printing: Approx. 14.0 W (ISO/
nection) IEC24712) IEC24712)
Ready mode: Approx. 3.0 W Ready mode: Approx.3.0 W
Sleep mode: Approx. 0.7 W Sleep mode: Approx. 0.7 W
Power off: Approx. 0.2 W Power off: Approx. 0.3 W

Note:
[ Check the label on the printer for its voltage.

[d For European users, see the following Website for details on power consumption.

http://www.epson.eu/energy-consumption

Environmental Specifications

Operation Use the printer within the range shown in the following graph.

%
80

55

20

Temperature: 10 to 35°C (50 to 95°F)

Humidity: 20 to 80% RH (without condensation)

Storage Temperature: -20 to 40°C (-4 to 104°F)"

Humidity: 5 to 85% RH (without condensation)

* You can store for one month at 40°C (104°F).

Environmental Specifications for Ink Bottles

Storage Temperature -20 t0 40 °C (-4 to 104 °F)"

Freezing Temperature -15°C(5°F)

Ink thaws and is usable after approximately 2 hours at 25 °C (77 °F).

* You can store for one month at 40 °C (104 °F).

System Requirements

d Windows 10 (32-bit, 64-bit)/Windows 8.1 (32-bit, 64-bit)/Windows 8 (32-bit, 64-bit)/Windows 7 (32-bit, 64-
bit)/Windows Vista (32-bit, 64-bit)/Windows XP SP3 or later (32-bit)/Windows XP Professional x64 Edition SP2
or later/Windows Server 2016/Windows Server 2012 R2/Windows Server 2012/Windows Server 2008 R2/
Windows Server 2008/Windows Server 2003 R2/Windows Server 2003 SP2 or later
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d macOS High Sierra/macOS Sierra/OS X El Capitan/OS X Yosemite/OS X Mavericks/OS X Mountain Lion/Mac
0OS X v10.7.x/Mac OS X v10.6.8

Note:
[ Mac OS may not support some applications and features.

(A The UNIX File System (UFS) for Mac OS is not supported.

Regulatory Information

Standards and Approvals

Standards and Approvals for European Model

For European users

Hereby, Seiko Epson Corporation declares that the following radio equipment model is in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity is available at the following website.

http://www.epson.eu/conformity
B631A

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Croatia, Cyprus, Greece,
Slovenia, Malta, Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

C€

Standards and Approvals for Australian Model

EMC AS/NZS CISPR32 Class B

Epson hereby declares that the following equipment Models are in compliance with the essential requirements and
other relevant provisions of AS/NZS4268:

B631A

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

Restrictions on Copying

Observe the following restrictions to ensure the responsible and legal use of the printer.

Copying of the following items is prohibited by law:
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(d Bank bills, coins, government-issued marketable securities, government bond securities, and municipal
securities

[J Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

[d Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

[d Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

[ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

Printers can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

Transporting and Storing the Printer

When you need to store the printer or transport it when moving or for repairs, follow the steps below to pack the
printer.
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n Important:

[ When storing or transporting the printer, place the printer in the plastic bag and fold it closed. Avoid tilting the
printer, placing it vertically, or turning it upside down; otherwise ink may leak.

d When storing or transporting an ink bottle, do not tilt the bottle and do not subject it to impacts or temperature
changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink
bottle upright when tightening the cap, and take precautions to prevent ink from leaking when transporting the
bottle, for example, putting the bottle in a bag.

1 Do not put opened ink bottles in the box with printer.

| 4

NE

1. Turn off the printer by pressing the O button.

2. Make sure the power light turns off, and then unplug the power cord.

n Important:

Unplug the power cord when the power light is off. Otherwise, the print head does not return to the home
position causing the ink to dry, and printing may become impossible.

3. Disconnect all cables such as the power cord and USB cable.

4. Remove all of the paper from the printer.
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5. Open the printer cover. Make sure you install the cap securely onto the ink tank.

8. Place the printer in the plastic bag and fold it closed.
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9. Pack the printer in its box using the protective materials.

g Important:

Make sure you keep the printer horizontal when transporting or storing the printer by packing it in its box;
otherwise ink may leak.

When you use the printer again, make sure you remove the tape securing the ink tank. If print quality has declined
the next time you print, clean and align the print head.

Related Information

= “Part Names and Functions” on page 11

= “Cleaning the Print Head (Head Cleaning)” on page 75
= “Aligning the Print Head” on page 77

Copyright

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of
Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the use of the information herein. The
information contained herein is designed only for use with this Epson product. Epson is not responsible for any
use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or
abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.)
failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of
any options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko
Epson Corporation.

© 2018 Seiko Epson Corporation

The contents of this manual and the specifications of this product are subject to change without notice.

Trademarks

[ EPSON@® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a
trademark of Seiko Epson Corporation.

d QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and other countries.

([ Microsoft®, Windows®, Windows Server®, and Windows Vista® are registered trademarks of Microsoft
Corporation.

(d Apple, Macintosh, macOS, OS X, Bonjour, ColorSync, Safari, iPad, iPhone, iPod touch, and iTunes are
trademarks of Apple Inc., registered in the U.S. and other countries.
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[d Google Cloud Print, Chrome, Chrome OS, Google Play and Android are trademarks of Google Inc.

[d Adobe and Adobe Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the
United States and/or other countries.

[d General Notice: Other product names used herein are for identification purposes only and may be trademarks
of their respective owners. Epson disclaims any and all rights in those marks.

Where to Get Help

Technical Support Web Site

If you need further help, visit the Epson support website shown below. Select your country or region and go to the
support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also
available from the site.

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If your Epson product is not operating properly and you cannot solve the problem, contact Epson support services
for assistance.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product manuals, contact Epson support services for assistance. If Epson support for your area
is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

[ Product serial number

(The serial number label is usually on the back of the product.)
(4 Product model

[ Product software version

(Click About, Version Info, or a similar button in the product software.)
(d Brand and model of your computer
(J Your computer operating system name and version

[d Names and versions of the software applications you normally use with your product
Note:
Depending on the product, network settings may be stored in the product’s memory. Due to breakdown or repair of a

product, settings may be lost. Epson shall not be responsible for the loss of any data, for backing up or recovering settings
even during a warranty period. We recommend that you make your own backup data or take notes.
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Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Taiwan

Contacts for information, support, and services are:

World Wide Web
http://www.epson.com.tw

Information on product specifications, drivers for download, and products enquiry are available.

Epson HelpDesk

Phone: +886-2-80242008

Our HelpDesk team can help you with the following over the phone:
[d Sales enquiries and product information

[d Product usage questions or problems

(J Enquiries on repair service and warranty

Repair service center:
http://www.tekcare.com.tw/branchMap.page

TekCare corporation is an authorized service center for Epson Taiwan Technology & Trading Ltd.

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product manuals,
we provide the following sources for obtaining information:

Internet URL
http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The
site provides a download area for drivers, Epson contact points, new product information and technical support (e-
mail).

Epson Helpdesk
Phone: 1300-361-054

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the
Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff
can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many
types of queries are answered here.

We encourage you to have all the relevant information on hand when you ring. The more information you prepare,
the faster we can help solve the problem. This information includes your Epson product manuals, type of
computer, operating system, application programs, and any information you feel is required.
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Transportation of Product

Epson recommends retaining product packaging for future transportation. Securing the ink tank with tape and
keeping the product upright is also recommended.

Help for Users in New Zealand

Epson New Zealand wishes to provide you with a high level of customer service. In addition to your product
documentation, we provide the following sources for obtaining information:

Internet URL
http://www.epson.co.nz

Access the Epson New Zealand World Wide Web pages. Worth taking your modem here for the occasional surf!
The site provides a download area for drivers, Epson contact points, new product information and technical
support (e-mail).

Epson Helpdesk
Phone: 0800 237 766

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the
Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff
can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many
types of queries are answered here.

We encourage you to have all the relevant information on hand when you ring. The more information you prepare,
the faster we can help solve the problem. This information includes your Epson product documentation, type of
computer, operating system, application programs, and any information you feel is required.

Transportation of Product

Epson recommends retaining product packaging for future transportation. Securing the ink tank with tape and
keeping the product upright is also recommended.

Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:

World Wide Web
http://www.epson.com.sg

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Sales Enquiries,
and Technical Support via e-mail are available.

Epson HelpDesk

Toll Free: 800-120-5564

Our HelpDesk team can help you with the following over the phone:
[ Sales enquiries and product information

[d Product usage questions or problem troubleshooting

[J Enquiries on repair service and warranty
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Help for Users in Thailand

Contacts for information, support, and services are:

World Wide Web
http://www.epson.co.th

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and e-mail are
available.

Epson Call Centre

Phone: 66-2685-9899

Email: support@eth.epson.co.th

Our Call Centre team can help you with the following over the phone:
[ Sales enquiries and product information

[d Product usage questions or problems

[J Enquiries on repair service and warranty

Help for Users in Vietham

Contacts for information, support, and services are:

Epson Service Center

65 Truong Dinh Street, District 1, Hochiminh City, Vietnam.
Phone(Ho Chi Minh City): 84-8-3823-9239, 84-8-3825-6234
29 Tue Tinh, Quan Hai Ba Trung, Hanoi City, Vietnam
Phone(Hanoi City): 84-4-3978-4785, 84-4-3978-4775

Help for Users in Indonesia

Contacts for information, support, and services are:

World Wide Web
http://www.epson.co.id
(d Information on product specifications, drivers for download

[ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Hotline

Phone: +62-1500-766

Fax: +62-21-808-66-799

Our Hotline team can help you with the following over the phone or fax:

[d Sales enquiries and product information
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Province Company Name Address Phone
E-mail
DKI JAKARTA ESS JAKARTA Ruko Mall Mangga Dua No. 48 JI. Arteri (+6221) 62301104
MANGGADUA Mangga Dua, Jakarta Utara - DKI JAKARTA . . . . .
jkt-admin@epson-indonesia.co.id
NORTH ESC MEDAN JI. Bambu 2 Komplek Graha Niaga Nomor (+6261) 42066090 / 42066091
SUMATERA A-4, Medan - North Sumatera . . .
mdn-adm@epson-indonesia.co.id
WEST JAWA ESC BANDUNG JI. Cihampelas No. 48 A Bandung Jawa (+6222) 4207033
Barat 40116 .
bdg-admin@epson-
indonesia.co.id
DI ESC YOGYAKARTA YAP Square, Block A No. 6 JI. C Simanjutak (+62274) 581065
YOGYAKARTA Yogyakarta - DIY . . . .
ygy-admin@epson-indonesia.co.id
EAST JAWA ESC SURABAYA Hitech Mall Lt. 2 Block A No. 24 JI. Kusuma (+6231) 5355035
No.116- 11 - JATIM
Bangsa No. 116 8 Surabaya - J sby-admin@epson-indonesia.co.id
SOUTH ESC MAKASSAR JI. Cendrawasih NO. 3A, kunjung mae, (+62411) 8911071
SULAWESI mariso, MAKASSAR - SULSEL 90125 .
mksr-admin@epson-
indonesia.co.id
WEST ESC PONTIANAK Komp. A yani Sentra Bisnis G33, JIl. Ahmad (+62561) 735507 / 767049
KALIMANTAN Yani - Pontianak Kalimantan Barat . .
pontianak-admin@epson-
indonesia.co.id
RIAU ESC PEKANBARU JI. Tuanku Tambusai No.459A Pekanbaru (+62761) 8524695
Ri
au pkb-admin@epson-
indonesia.co.id
DKI JAKARTA ESS JAKARTA Wisma Keiai Lt. 1 JI. Jenderal Sudirman Kav. (+6221) 5724335
SUDIRMAN 3 Jakarta Pusat - DKI JAKARTA 10220 . . .
ess@epson-indonesia.co.id
EAST JAWA ESS SURABAYA Ruko Surya Inti JI. Jawa No 2-4 Kav. 29 (+6231) 5014949
Surabaya - Jawa Timur . . .
esssby@epson-indonesia.co.id
BANTEN ESS SERPONG Ruko Mall WTC Matahari No. 953, Serpong- (+6221) 53167051 /53167052
Banten . . .
esstag@epson-indonesia.co.id
CENTRAL ESS SEMARANG Komplek Ruko Metro Plaza Block C20 JI. MT (+6224) 8313807 / 8417935
JAWA Haryono No 970 Semarang - JAWA TENGAH . . .
esssmg@epson-indonesia.co.id
EAST ESC SAMARINDA JI. KH. Wahid Hasyim (M. Yamin) Kelurahan (+62541) 7272904
KALIMANTAN Sempaja Selatan Kecamatan Samarinda d ind . i
UTARA - SAMARINDA - KALTIM escsmd@epson-indonesia.co.i
SOUTH ESC PALEMBANG JI. H.M Rasyid Nawawi No. 249 Kelurahan 9 (+62711) 311330
SUMATERA llir Palembang Sumatera Selatan

escplg@epson-indonesia.co.id
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E-mail
EAST JAVA ESC JEMBER JL. Panglima Besar Sudirman Ruko no.1D (+62331) 488373 / 486468

Jember-Jawa Timur (Depan Balai Penelitian

& Pengolahan Kakao) jmr-admin@epson-indonesia.co.id

NORTH ESC MANADO Tekno Megamall Lt LG 11 TK 21, Kawasan (+62431) 8890996
SULAWESI Megamas Boulevard, JI Piere Tendean,
Manado- SULUT 95111 MND-ADMIN@EPSON-
INDONESIA.CO.ID

For other cities not listed here, call the Hot Line: 08071137766.

Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact Epson Hong Kong
Limited.

Internet Home Page
http://www.epson.com.hk

Epson Hong Kong has established a local home page in both Chinese and English on the Internet to provide users
with the following information:

[ Product information
4 Answers to Frequently Asked Questions (FAQs)

[ Latest versions of Epson product drivers

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:
Phone: 852-2827-8911

Fax: 852-2827-4383

Help for Users in Malaysia

Contacts for information, support, and services are:

World Wide Web
http://www.epson.com.my
[d Information on product specifications, drivers for download

(d Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Call Centre
Phone: +60 1800-8-17349

[ Sales enquiries and product information

(d Product usage questions or problems
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[d Enquiries on repair services and warranty

Head Office
Phone: 603-56288288
Fax: 603-5628 8388/603-5621 2088

Help for Users in India

Contacts for information, support, and services are:

World Wide Web
http://www.epson.co.in

Information on product specifications, drivers for download, and products enquiry are available.

Helpline

[ Service, product information, and ordering consumables (BSNL Lines)
Toll-free number: 18004250011
Accessible 9am to 6pm, Monday through Saturday (Except public holidays)

[ Service (CDMA & Mobile Users)
Toll-free number: 186030001600
Accessible 9am to 6pm, Monday through Saturday (Except public holidays)

Help for Users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the Epson Philippines
Corporation at the telephone, fax numbers and e-mail address below:

World Wide Web
http://www.epson.com.ph

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and E-mail
Enquiries are available.

Epson Philippines Customer Care

Toll Free: (PLDT) 1-800-1069-37766

Toll Free: (Digital) 1-800-3-0037766

Metro Manila: (+632)441-9030

Web Site: https://www.epson.com.ph/contact

E-mail: customercare@epc.epson.som.ph

Accessible 9am to 6pm, Monday through Saturday (Except public holidays)
Our Customer Care team can help you with the following over the phone:
[ Sales enquiries and product information

(d Product usage questions or problems
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Epson Philippines Corporation
Trunk Line: +632-706-2609
Fax: +632-706-2663
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